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LET TER FROM THE PRESIDENT

Hi Blues Fans, 

This year is just racing by and 
so much cool music ahead of us 
this spring, summer, and fall! 
You will find ads for Sunbanks 
(Blues and Country Events), 
Winthrop, Gorge Blues & 
Brews, and the list just goes on. 
I hope that many of you are able 
to get out and have some fun at 
our many celebrations of music 
that are offered by the many 

first-class events we have in the greater Pacific Northwest! 

The Washington Blues Society will be featuring a lot of new merchandise in 
our booth at most of these festivals. I have ordered a new stock of our sig-
nature black shirts with the large WBS logo. The Embossed Flaming Guitar 
shirts will also be making a come back and a few other surprises too! Be sure 
to stop by the booth and check these new items out! 

In this issue you will also find the International Blues Challenge instruction 
and entry forms for the Washington Blues Societies Semi-finals that are 
spread out across the state so that potential entrants can throw their hat in 
compete for a chance to go to Memphis Tennessee and show their talents in 
the Blues Foundation’s International Blues Challenge. I highly recommend 
this for any band or solo/duo who want to explore this opportunity of a life 
time. I have seen this opportunity change musicians lives and open doors 
to many incredible opportunities. 

Don’t forget that the Washington Blues society is offering two different Blues 
Bashes a month now! We have our traditional Second Tuesday Bash at the 
Aurora Borealis. And our new fourth Tuesday Blues Bash out in Snohom-
ish at the Collector’s Choice in the Old Man Brewery room. This new event 
is growing in attendance and sending music fans home with big smiles on 
the faces and their toes tapping. Get out of the house and attend these fun 
monthly events, enjoy some good music and let someone else cook dinner! 
You may even go home with a new CD or tickets to a cool show at one of 
Seattle’s many outstanding music venues from our free drawings at all of our 
Blues Bashes! Previews of each of these bashes are always available in the 
Bluesletter to help you in planning your adventures! 

As always, I hope to see many of you out and about and be sure to stop by 
and say “Hi” 

Tony Frederickson, President
 Washington Blues Society 
Member, Board of Directors, The Blues Foundation (2015-2017)
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In this issue we cover the new partnership between 
Washington’s own harmonica master Lee Oskar and Rolling 
Stones frontman Mick Jagger on a line of Mick Jagger 
harmonicas. Oskar is not only a harmonica player who 
revolutionized the instrument with the band War and who 
is now manufacturer of the world’s third-largest harmonica 
company, Lee Oskar Harmonicas; he is quite a nice guy.
Also we get a preview of concerts coming to the region in 
May, in Eric Steiner’s Blues on the Road article. 
A student writer from the University of Washington presents 
a piece on the progress of the Black and Tan Hall, a non-
profit venue that celebrates the history of Seattle’s Black and 
Tan Club. The historic club was a rare desegregated venuea 
in the 1920s and was a premium location for blues and jazz 
through the 1960s. 
In the new regular feature “Gospel in the Northwest” is a 
story on Sounds of the Northwest, a Seattle choir that is one 
of the few in the nation to do African-American music pre-
dating gospel. And in this issue we also have a preview of 
the impressive Winthrop Rhythm and Blues Festival lineup. 
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LET TER FROM THE EDITORLET TER FROM THE EDITOR

This is my third issue as This is my third issue as 
editor, and I am slowly editor, and I am slowly 
getting the hang of the getting the hang of the 
software we use to lay the software we use to lay the 
pages out. This month I laid pages out. This month I laid 
out half the pages and am out half the pages and am 
quite pleased with myself quite pleased with myself 
about it. This month I am about it. This month I am 
also proud to announce that also proud to announce that 
Sean “Gatorboy” Donovan, Sean “Gatorboy” Donovan, 
the  graphic  des igner the  graphic  des igner 
responsible for much of responsible for much of 
the art used on Winthrop the art used on Winthrop 
Rhythm and Blues Festival Rhythm and Blues Festival 
materials, who also laid out materials, who also laid out 
the cover featuring Sugaray the cover featuring Sugaray 
Rayford for the March Rayford for the March 

issue, has volunteered to lay out our covers going forward. He’s an issue, has volunteered to lay out our covers going forward. He’s an 
amazing guy, friendly and skilled and generous, and this publication amazing guy, friendly and skilled and generous, and this publication 
is going to look incredible with his help. is going to look incredible with his help. 

Speaking of the cover, working on the cover story for this issue was Speaking of the cover, working on the cover story for this issue was 
a joy. I’ve had the pleasure of meeting harmonica legend Lee Oskar a joy. I’ve had the pleasure of meeting harmonica legend Lee Oskar 
several times and every time was struck by his generosity of spirit. several times and every time was struck by his generosity of spirit. 
Once, while playing bass for the nonprofit United By Music North Once, while playing bass for the nonprofit United By Music North 
America, which makes music performance available to musicians America, which makes music performance available to musicians 
with intellectual disabilities, I played bass behind Lee Oskar on a with intellectual disabilities, I played bass behind Lee Oskar on a 
performance of his iconic War hit “Lowrider.” You can believe I was performance of his iconic War hit “Lowrider.” You can believe I was 
nervous, but he was welcoming and complimentary. nervous, but he was welcoming and complimentary. 

So, when it came time to interview him for this issue, I was looking So, when it came time to interview him for this issue, I was looking 
forward to a good conversation. Lee exceeded my expectations. forward to a good conversation. Lee exceeded my expectations. 
Had I not known that he is one of his generation’s most influential Had I not known that he is one of his generation’s most influential 
instrumentalists and the maker of one of the world’s top-selling instrumentalists and the maker of one of the world’s top-selling 
harmonicas, I would certainly not have guessed from his demeanor. harmonicas, I would certainly not have guessed from his demeanor. 
He is self-effacing, interested in everyone and everything, and He is self-effacing, interested in everyone and everything, and 
genuinely nice. We ended up talking for a couple of hours. A week genuinely nice. We ended up talking for a couple of hours. A week 
later I received a package in the mail containing some harmonicas, later I received a package in the mail containing some harmonicas, 
stickers, and a copy of his album “Never Forget.” stickers, and a copy of his album “Never Forget.” 

(As a side note, when one of the world’s top harmonica players and (As a side note, when one of the world’s top harmonica players and 
manufacturers sends you a harmonica, it is clearly a nudge from the manufacturers sends you a harmonica, it is clearly a nudge from the 
universe that you should learn to play harmonica, so I am practicing.) universe that you should learn to play harmonica, so I am practicing.) 

This being a blues publication, we didn’t review that album, which This being a blues publication, we didn’t review that album, which 
is a mélange of classical and world music. If I had reviewed it, I’d is a mélange of classical and world music. If I had reviewed it, I’d 
have run out of ink before I was done. The album is Lee’s reflection have run out of ink before I was done. The album is Lee’s reflection 
on his lifetime of confronting his family’s experience during the on his lifetime of confronting his family’s experience during the 
holocaust. Though the musical arrangements are quite sophisticated holocaust. Though the musical arrangements are quite sophisticated 
and incorporate a dazzling array of instruments, Lee’s harmonica and incorporate a dazzling array of instruments, Lee’s harmonica 
parts provide strong, clear melodies that remind me of Gershwin parts provide strong, clear melodies that remind me of Gershwin 
and Astor Piazzolla in their memorability. It’s haunting music, tragic and Astor Piazzolla in their memorability. It’s haunting music, tragic 
and hopeful at once. and hopeful at once. 

For the record, I will forever be salty that it didn’t get a Grammy For the record, I will forever be salty that it didn’t get a Grammy 
nomination. It is the masterwork of one of music’s greatest modern nomination. It is the masterwork of one of music’s greatest modern 
innovators on one of the world’s most troubling themes. For people innovators on one of the world’s most troubling themes. For people 

like me who have eclectic musical taste I can’t recommend that like me who have eclectic musical taste I can’t recommend that 
album highly enough. album highly enough. 

The interview and the subsequent thoughtful package got me The interview and the subsequent thoughtful package got me 
reflecting on being a performer. I have often thought that being a reflecting on being a performer. I have often thought that being a 
performer provides me with a handful of glitter for the day. I know performer provides me with a handful of glitter for the day. I know 
what it’s like to approach someone whose music I like to pay my what it’s like to approach someone whose music I like to pay my 
compliments. It’s a vulnerable moment. So, when I am fortunate compliments. It’s a vulnerable moment. So, when I am fortunate 
enough to be approached in that capacity, I have an opportunity enough to be approached in that capacity, I have an opportunity 
to glitter that person. I can focus, see that person, listen, engage, to glitter that person. I can focus, see that person, listen, engage, 
and leave that person affirmed and happy. Lee, of course, is orders and leave that person affirmed and happy. Lee, of course, is orders 
of magnitude more notable than I am, and therefore probably gets of magnitude more notable than I am, and therefore probably gets 
approached a lot more than I do, but he is unstinting with that approached a lot more than I do, but he is unstinting with that 
handful of glitter. We are fortunate to claim him as a member of handful of glitter. We are fortunate to claim him as a member of 
Washington’s music community. Washington’s music community. 

Polly O’Keary, Editor
Washington Blues Society Bluesletter
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Painted Black: Lee Oskar releases line of Mick Jagger harmonicas  Painted Black: Lee Oskar releases line of Mick Jagger harmonicas  
Lee Oskar and Mick Jagger collaborate on scarlet and ebony line of Mick Jagger harmonicas

By Polly O’Keary, EditorBy Polly O’Keary, Editor

In 1983, when he got the first harmonicas 
he’d designed for sale under his own 
name, Lee Oskar had to figure out how 
to get other people to buy them. As the 
pioneering harmonica player who brought 
the instrument into the horn section, famed 
worldwide for his work with the seminal 
funk band War, he had credibility. He just 
didn’t have a ton of money for promotion. 
That, he says, was a good thing. 
“Thank God I didn’t have money for 
advertising,” he said. Advertising, he believes, 
is for confirming the excitement about an 
existing product, not for creating excitement 
about something unknown. His strategy was 
to get his harmonicas to other players, get 
people talking about them, and get them 
into media stories. Then, he believed, players 
would hear about the harmonicas through 
word of mouth, try them out, and become 
loyal customers. 
It worked. 
Forty years later, Lee Oskar harmonicas 
are the third largest maker of harmonicas 
in the world; a fact that is made even more 
impressive considering that harmonicas are 
the world’s top-selling instrument, with 3 
million sold each year. 
And now Mick Jagger is putting his name 
on a limited-edition line of Lee Oskar 
harmonicas, a sleek red and black instrument 
with Jagger’s name on one side and Oskar’s 

on the other, only available online through 
Jagger’s son’s company whynow. 
“Mick Jagger uses my product, claims 
it’s the best in the world, and he can pick 
anything,” said Oskar in an interview with 
the Washington Bluesletter.  “That’s to me is 
real. It’s what I live for.”
It’s a formidable endorsement for a product 
that was originally created because Oskar 
simply wanted to play something he liked. 
He was famous for his skill and innovation 
as a harmonica player, but he could never get 
the exact sound and experience he wanted 
from the harmonicas available at the time. 
So out of sheer frustration, Oskar decided to 
design his own harmonica. 
“I didn’t get into this business to make 
money,” said Oskar. “You have to have 
passion, and a desperation to have the right 
tools.”
Despite his frustration, Oskar took his time 
developing his line of instruments. After a 
careful exploration of the world of harmonica 
production, he found Tombo, a company in 
Japan that had been making harmonicas 
since 1917. 
Although harmonica is often associated with 
American blues music and the American 
west, the instrument became popular in 
Japan more than a century ago. Japanese 
harmonica makers eventually started making 
instruments tuned to the scales used on 
Japanese folk songs, called “Japanese tremolo 

tuning.” From then on, Japan led the world 
in innovation of the instrument, adding 
different scales including minor keys. 
When Oskar met with Tombo president Yasu 
Harumano and the rest of the Mano family, 
they were already fans of his and eager to meet. 
Together, they developed an instrument 
that met all of Oskar’s desires. It wasn’t 
harsh but had a sweet tone. The brass was 
carefully chosen. The instruments had 
replaceable parts; unlike most harmonicas, 
when a reed wore out on a Lee Oskar 
harmonica, the player didn’t have to throw 
it away. Also, although harmonica was 
primarily associated with blues, Oskar 
wanted harmonicas suitable for playing 
any style of music. So, the company worked 
with him to develop instruments tuned to 
play reggae, clave, jazz, Yiddish, and more. 
In the beginning, the success of Oskar’s 
unorthodox marketing strategy took 
others in the industry by surprise.
“I had created so much demand from 
magazines writing about them, people 
playing them, and word of mouth, a 
lot of people took it on,” Oskar said. 
When he became unhappy with his 
distribution company, he learned who the 
top distributor of harmonicas was. He was 
warned that he was not yet a big enough name 
for that distributor, but Oskar called anyway.
“The guy on the phone said, ‘Is this Lee 
Oskar? Please come in. Salespeople are 
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getting beat up because all these people are 
coming and saying, ‘how do I get those damn 
Lee Oskar harmonics?’’” Oskar recalled. “I’ve 
been with them for 36 years now.” 
After his harmonicas had been on the market 
for about 10 years, Oskar got a gratifying 
call. The Rolling Stones were recording in 
LA, and Mick Jagger wanted to buy several 
Lee Oskar harmonicas. 
A bigger name selecting his harmonicas was 
impossible to imagine. Jagger had started 
playing after hearing the work of Little 
Walter and Sonny Boy Williamson, two of 
the great innovators of the instrument. He 
wanted to be able to contribute more to the 
Rolling Stones’ work than just vocals, too. 
His efforts paid off. He had such a natural 
ability on the instrument that even his 
famously cantankerous bandmate Keith 
Richards bestowed rare praise on his ability. 
On his own online video series “Ask Keith,” 
Richards said, “To me, Mick Jagger is one of 
the best blues harp players in the world. He 
does things you wouldn’t dream of vocally.”

Jagger’s  harmonica  work  b ecame 
foundational to the Stones’ sound on such 
songs as “Midnight Rambler,” “Miss You,” 
“Sweet Virginia,” and “When You’re Gone.” 
For Oskar, it was nice to know that one of the 
world’s most famous musicians had chosen 
his brand. He frequently saw pictures of 
Jagger playing his harmonicas, and roadies 
from the Stones tours would sometimes call 
to get more. 
Oskar loved Jagger’s playing, too. Not only 
was he technically proficient, but he played 
with passion, which for Oskar is the single 
most important quality a musician can 
express. 
The two artists never met, however, in 
spite of their considerable mutual fame 
and authority as harmonica players. And 
Oskar never mentioned Jagger’s choice of 
harmonicas. He felt it would be improper 
to capitalize on an artist’s name without that 
artist’s consent or awareness.
Then, a couple of years ago, Mick Jagger’s 
son Gabriel came to him. Gabriel Jagger 
has a company of his own called whynow 
Music that partners with artists to create 
products directly available to fans through 
the company’s website. His father, Mick 
Jagger, was interested in partnering with 
Oskar on a line of Mick Jagger harmonicas; 
was Oskar interested? 
He was. 
In a January 25 tweet, Jagger posted a video of 
himself playing one of the new harmonicas, 
along with the message, “Always loved 
Lee Oskar harmonicas and now I’ve been 
lucky enough to collaborate with them on a 
harmonica of my own.”
The first round of harmonicas sold out 
through presales and were shipped February 
8. But there are more on the way.
How the future product will be rolled out 
is still under some discussion; they will 
be available at whynow.com and at Jagger 
performances, and Oskar will sell them in 

such a way that the two companies don’t 
wind up competing. 
Recognition and acclamation from 
artists mean a lot to Oskar. And this new 
partnership is the kind of reward for a life in 
making instruments that lifts him the most. 
“To me, the highlights in the 40 years of 
manufacturing are two things,” he said. “The 
first is that I’ve had 40 years of manufacturing 
a consistent product with a perfect team. The 
second is being acknowledged by people 
like Bobby Rush, Taj Mahal, and John 
Nemeth now, who are highly respected for 
harmonica. This acknowledgment from 
Mick Jagger is the icing on the cake. It’s a 
great feeling.”
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Blues You Can Use: May 2023 Blues Bash Previews
Mark your calendars for live blues on the 9th in Shoreline & the 28th in Snohomish! Mark your calendars for live blues on the 9th in Shoreline & the 28th in Snohomish! 

Compiled by Rick BowenCompiled by Rick Bowen
The Washington Blues Society Blues Bash The Washington Blues Society Blues Bash 
continues with two in person live events continues with two in person live events 
on the 2on the 2ndnd & 4 & 4thth Tuesdays of the month!  Tuesdays of the month! 
On the 9On the 9thth at the Aurora Borealis, 16708  at the Aurora Borealis, 16708 
Aurora Avenue North in Shoreline at 7 Aurora Avenue North in Shoreline at 7 
PM, and on the 28PM, and on the 28thth   at CCR Sports and    at CCR Sports and 
EntertainmentEntertainment, 215 Cypress Avenue in , 215 Cypress Avenue in 
Snohomish at 7 PM.Snohomish at 7 PM.
The first   Blues Bash features music from The first   Blues Bash features music from 

acoustic trio Crushed Velvet and the acoustic trio Crushed Velvet and the 
Skagit Valley-based blues group The CC Skagit Valley-based blues group The CC 
Adams Band. The second Blues Bash Adams Band. The second Blues Bash 
will feature a solo set from guitarist will feature a solo set from guitarist 
Brian Butler and first time Blues Bash Brian Butler and first time Blues Bash 
performers The Cold 102s. The monthly performers The Cold 102s. The monthly 
Washington Blues Society Blues Bashes are Washington Blues Society Blues Bashes are 
presented free, and all are welcome. The presented free, and all are welcome. The 
Aurora Borealis is an all ages venue,  and Aurora Borealis is an all ages venue,  and 
CCR Sports and Entertainment is reserved CCR Sports and Entertainment is reserved 
for patrons 21+. We will have a door prize for patrons 21+. We will have a door prize 
raffle with great prizes, including tickets raffle with great prizes, including tickets 
to Jazz Alley, Seattle’s Neptune Theater, to Jazz Alley, Seattle’s Neptune Theater, 
and more. We encourage everyone to Tip and more. We encourage everyone to Tip 
the Band  in support of their volunteer the Band  in support of their volunteer 
performances.  More about May’s Blues performances.  More about May’s Blues 
Bash performers: Bash performers: 

Crushed Velvet (Photo by Alexandra Seelye)Crushed Velvet (Photo by Alexandra Seelye)
Crushed VelvetCrushed Velvet: : The acoustic trio Crushed The acoustic trio Crushed 
Velvet is a new venture featuring veteran Velvet is a new venture featuring veteran 
musicians Alexandra Seelye on vocals and musicians Alexandra Seelye on vocals and 

guitar, Jimmy Culler on bass and vocals,  guitar, Jimmy Culler on bass and vocals,  
and Greg Murat on guitar vocals and and Greg Murat on guitar vocals and 
percussion. The trio plays a warm mix of percussion. The trio plays a warm mix of 
genres focusing on sweet vocal harmonies genres focusing on sweet vocal harmonies 
that have earned them accolades including that have earned them accolades including 
a nomination for Best New Blues Act from a nomination for Best New Blues Act from 
the Washington Blues Society.  the Washington Blues Society.  

The CC Adams Band (Photo by CC Adams)The CC Adams Band (Photo by CC Adams)
CC Adams Band: Powerhouse vocalist CC Adams Band: Powerhouse vocalist 
Marry Ellen Lykins fronts the CC Adams Marry Ellen Lykins fronts the CC Adams 
Band from Skagit County. The six piece Band from Skagit County. The six piece 
band’s roots are in the Blues with R&B and band’s roots are in the Blues with R&B and 
tasty rock mixed in for flavor. Thwarting tasty rock mixed in for flavor. Thwarting 
the conventional, the group thrives on the conventional, the group thrives on 
unique arrangements playing what they unique arrangements playing what they 
call “Dancin' Music.” call “Dancin' Music.” 

Brian Butler (Photo by Dave Corry)Brian Butler (Photo by Dave Corry)
Brian Butler: Blues guitarist, singer and Brian Butler: Blues guitarist, singer and 
songwriter Brian Butler has been playing songwriter Brian Butler has been playing 
the blues around the northwest for years. the blues around the northwest for years. 

The Brian Butler Blues Band was a favorite The Brian Butler Blues Band was a favorite 
on the scene for many years and performs on the scene for many years and performs 
occasionally. The band backed up Albert occasionally. The band backed up Albert 
Collins, Eddie Taylor, Elvin Bishop Collins, Eddie Taylor, Elvin Bishop 
among others and has featured a number among others and has featured a number 
of talented local players over the years. of talented local players over the years. 
As a solo performer, Brian plays acoustic As a solo performer, Brian plays acoustic 
and electric guitar and rack harmonica and electric guitar and rack harmonica 
and is a soulful singer. His shows feature and is a soulful singer. His shows feature 
original songs  in addition to classic blues. original songs  in addition to classic blues. 
The Washington Blues Society awarded The Washington Blues Society awarded 
Brian’s latest CD, Brian’s latest CD, Butler’s BluesButler’s Blues, Best Blues , Best Blues 
Recording of 2019 as well as Best Acoustic Recording of 2019 as well as Best Acoustic 
Blues Guitarist Awards in 2020 and 2021. Blues Guitarist Awards in 2020 and 2021. 
He also won the Lee Oskar Harmonica He also won the Lee Oskar Harmonica 
Award in the regional 2021 Points West Award in the regional 2021 Points West 
Virtual Showdown. Virtual Showdown. 

The Cold 102s (Photo by Johnny Horn)The Cold 102s (Photo by Johnny Horn)
The Cold 102sThe Cold 102s: : Four words define one of Four words define one of 
the Northwest's finest blues bands: “The the Northwest's finest blues bands: “The 
Blues That Soothes.” The Cold 102s have Blues That Soothes.” The Cold 102s have 
been filling prescriptions with no need for been filling prescriptions with no need for 
copay or spenddown since 2007 and have copay or spenddown since 2007 and have 
been doing so gleefully, with core members been doing so gleefully, with core members 
Anthony "Antoine Dooron" Estrada Anthony "Antoine Dooron" Estrada 
(vocals, guitar, harmonica, percussion) (vocals, guitar, harmonica, percussion) 
and Leonard "The Lion" Daniel (drums), and Leonard "The Lion" Daniel (drums), 
who had played for years in late Chicago who had played for years in late Chicago 
bluesman Richard Molina's band. The two bluesman Richard Molina's band. The two 
met after the 102s had gone through many met after the 102s had gone through many 
lineup changes, finally settling on Johnny lineup changes, finally settling on Johnny 
Horn (host of ‘Preachin' the Blues’ on Horn (host of ‘Preachin' the Blues’ on 
KEXP) on bass and Curtis Smith on guitar. KEXP) on bass and Curtis Smith on guitar. 
The band has a funky, upbeat, soulful, The band has a funky, upbeat, soulful, 
Gospel-infused, but very unique, sound Gospel-infused, but very unique, sound 
that holds true to its roots in blues from that holds true to its roots in blues from 
all regions that is sure to get any crowd all regions that is sure to get any crowd 
rocking and swinging in no time!rocking and swinging in no time!
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By Rick J. Bowen 

Beale Street was windy, cold, and sometimes Beale Street was windy, cold, and sometimes 
wet as January often can be in Memphis, wet as January often can be in Memphis, 
and yet the stout-hearted blues fans were and yet the stout-hearted blues fans were 
undeterred and filled the clubs for the 2023 undeterred and filled the clubs for the 2023 
international Blues Challenge. international Blues Challenge. 

The buzz on the street began immediately The buzz on the street began immediately 
following the Tuesday night kickoff with following the Tuesday night kickoff with 
the International Showcase at Club 152, the International Showcase at Club 152, 
with folks remarking about the exceptional with folks remarking about the exceptional 
performances from Australian, French, performances from Australian, French, 
Korean, and UK acts. Korean, and UK acts. 

The Pacific Northwest Showcase played to a The Pacific Northwest Showcase played to a 
full house before the competition began in full house before the competition began in 
earnest on Wednesday. earnest on Wednesday. 

The specter of civil unrest began to creep The specter of civil unrest began to creep 
into the week on Thursday as news of a video into the week on Thursday as news of a video 
released around the controversial death of released around the controversial death of 
a local man, Tyre Nichols, was announced. a local man, Tyre Nichols, was announced. 
Only one official activity was cancelled as Only one official activity was cancelled as 
The Blues Foundation worked with local The Blues Foundation worked with local 
law enforcement to ensure the safety of blues law enforcement to ensure the safety of blues 
fans and musicians. fans and musicians. 

When the Friday night semifinalists were When the Friday night semifinalists were 
announced, our Pacific Northwest entrants announced, our Pacific Northwest entrants 
had not made the cut, but had given their all had not made the cut, but had given their all 
with fine performances. with fine performances. 

The finals began on Saturday The finals began on Saturday 
with a moment of silence in with a moment of silence in 
honor of Tyre Nichols and his honor of Tyre Nichols and his 
family. In the band division, family. In the band division, 
a cross section of genres took a cross section of genres took 
the top three spots, with the top three spots, with 
Dick Earle’s Electric Witness Dick Earle’s Electric Witness 
delivering red dirt blues, and delivering red dirt blues, and 
blue-eyed soul from The blue-eyed soul from The 
Cinelli Brothers took second Cinelli Brothers took second 
place. The championship trio place. The championship trio 
led by 20-year-old phenom led by 20-year-old phenom 
Mathias Lattin, who also won Mathias Lattin, who also won 
the best guitar award, gave the best guitar award, gave 
us a show of straight ahead us a show of straight ahead 
Texas Blues.Texas Blues.

In a twist of fate, this In a twist of fate, this 
year’s International Blues year’s International Blues 
Challenge-winning band Challenge-winning band 
had taken high scores in the had taken high scores in the 
same venue as Eric's Maine same venue as Eric's Maine 
Connection, bumping the Connection, bumping the 
Washington state band out Washington state band out 
of the race. Australian Frank of the race. Australian Frank 
Sultana took the solo/duo Sultana took the solo/duo 

crown, with husband-and-wife duo The crown, with husband-and-wife duo The 
Sugar Thieves taking second place. Sugar Thieves taking second place. 

In honor of their 40th anniversary, In honor of their 40th anniversary, 
Washington based Lee Oskar Harmonicas Washington based Lee Oskar Harmonicas 
not only presented the annual harmonica not only presented the annual harmonica 
award but gave every placeholder a prize award but gave every placeholder a prize 
package. Throughout the week workshops package. Throughout the week workshops 
and showcases took place each afternoon and showcases took place each afternoon 
and after-hours jam sessions kept the music and after-hours jam sessions kept the music 
going to the wee hours. going to the wee hours. 

Bob Margolin held court at the Rum Boogie Bob Margolin held court at the Rum Boogie 
Cafe for three nights, as this former sideman Cafe for three nights, as this former sideman 
with Muddy Waters made his first public with Muddy Waters made his first public 
performances since lockdown. John del performances since lockdown. John del 
Toro hosted two All Star jams and locals Toro hosted two All Star jams and locals 
Eric Hughes and the Ghost Town Blues Eric Hughes and the Ghost Town Blues 
Band hosted packed rooms. A first time all-Band hosted packed rooms. A first time all-
harmonica jam took place as well, and the harmonica jam took place as well, and the 
International Blues Challenge will return to International Blues Challenge will return to 
Beale Street in January of 2024.Beale Street in January of 2024.

Report From Memphis: 2023 International Blues Challenge 
“The buzz on the street began immediately following the Tuesday night kickoff...”“The buzz on the street began immediately following the Tuesday night kickoff...”

Above: Eric’s Maine Connection plays their 
first set at the International Blues Challenge in 
Memphis. 
Left: Washington Blues Society’s Son Jack Jr. 
returns to Memphis!
Photos by Wendy Rice
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Previews: Blues on the Road!
Join the Washington Blues Society in welcoming nationally touring artists to the Evergreen State! 

By Eric Steiner

Here is a sampling of national acts touring Here is a sampling of national acts touring 
through Washington and the Pacific through Washington and the Pacific 
Northwest this month. Northwest this month. 

Reverend Horton Heat, The Delta Bombers Reverend Horton Heat, The Delta Bombers 
& The Dusty 45’s& The Dusty 45’s

On the 1st, Rev. Horton Heat, The Delta On the 1st, Rev. Horton Heat, The Delta 
Bombers, and the Dusty 45’s play in Idaho Bombers, and the Dusty 45’s play in Idaho 
at the Argyros Performance Hall in Ketchum at the Argyros Performance Hall in Ketchum 
followed by the Neurolux Lounge on the 2nd. followed by the Neurolux Lounge on the 2nd. 
The tour continues to Oregon with shows at The tour continues to Oregon with shows at 
the Old Volcanic Theatre Pub in Bend on the the Old Volcanic Theatre Pub in Bend on the 
4th and the Bossanova Ballroom in Portland 4th and the Bossanova Ballroom in Portland 
on the 5th. In the Evergreen State, the three on the 5th. In the Evergreen State, the three 
bands play El Corazon in Seattle on the bands play El Corazon in Seattle on the 
6th, the Redwood Theatre in Bremerton on 6th, the Redwood Theatre in Bremerton on 
the 8th. Heat & the Bombers play the Wild the 8th. Heat & the Bombers play the Wild 
Buffalo House of Music in Bellingham on the Buffalo House of Music in Bellingham on the 
7th. I remember Dusty 45’s bandleader Billy 7th. I remember Dusty 45’s bandleader Billy 
Joe Huels on the June, 2019 festival preview Joe Huels on the June, 2019 festival preview 
issue that featured Keeping the Blues Alive issue that featured Keeping the Blues Alive 
Award recipient Marilyn Stringer’s cover Award recipient Marilyn Stringer’s cover 
photo.photo.

Ottmar Liebert & Luna NegraOttmar Liebert & Luna Negra

Welcome Ottmar Liebert & Luna Negra Welcome Ottmar Liebert & Luna Negra 
back to Portland at the Alberta Rose Theatre back to Portland at the Alberta Rose Theatre 
on the 10th and then Seattle at Jazz Alley on the 10th and then Seattle at Jazz Alley 
from May 11th to the 14th. Joining Liebert from May 11th to the 14th. Joining Liebert 
at Jazz Alley will be bassist Jon Gagan and at Jazz Alley will be bassist Jon Gagan and 
drummer/percussionist Robby Rothschild. drummer/percussionist Robby Rothschild. 
Looking at my calendar, I simply can’t Looking at my calendar, I simply can’t 
believe I first discovered Ottmar Liebert & believe I first discovered Ottmar Liebert & 
Luna Negra in 1992 on the exceptional Solo Luna Negra in 1992 on the exceptional Solo 
Para Ti CD.Para Ti CD.

The Guess WhoThe Guess Who

When I was in junior high in Chicagoland, I When I was in junior high in Chicagoland, I 
saved up my paper route money and bought saved up my paper route money and bought 
Live at the Paramount, a classic LP from Live at the Paramount, a classic LP from 
1972 from the Guess Who. Little did I know 1972 from the Guess Who. Little did I know 
then that I would eventually relocate to the then that I would eventually relocate to the 
Pacific Northwest and see shows there. On Pacific Northwest and see shows there. On 
the 12th, Bremerton’s Admiral Theatre the 12th, Bremerton’s Admiral Theatre 
hosts The Guess Who, followed by a show hosts The Guess Who, followed by a show 
at Tacoma’s Pantages Theatre on the 14th. at Tacoma’s Pantages Theatre on the 14th. 
This year’s tour features original drummer This year’s tour features original drummer 
Barry Peterson with Derek Sharp on guitars Barry Peterson with Derek Sharp on guitars 
and vocals, multinstrumentalist Leonard and vocals, multinstrumentalist Leonard 
Shaw, guitarist Michael Staertow, and bassist Shaw, guitarist Michael Staertow, and bassist 
Michael Devin. Michael Devin. 

Blood Brothers Tour: Mike Zito & Albert Blood Brothers Tour: Mike Zito & Albert 
CastigliaCastiglia

New blues and roots super group Blood New blues and roots super group Blood 
Brothers, featuring multi-Blues Music Brothers, featuring multi-Blues Music 
Award-winners Mike Zito and Albert Award-winners Mike Zito and Albert 
Castiglia, bring their tour to the Pacific Castiglia, bring their tour to the Pacific 
Northwest in May in support of their self-Northwest in May in support of their self-
titled debut album with stops in Portland, titled debut album with stops in Portland, 
Everett, and the Sunbanks Blues Festival. Everett, and the Sunbanks Blues Festival. 

Mike Zito and Albert Castiglia are true Mike Zito and Albert Castiglia are true 
“Blood Brothers” in life and in music. For the “Blood Brothers” in life and in music. For the 
Blood Brothers Tour, both Mike and Albert Blood Brothers Tour, both Mike and Albert 
will be onstage performing together for the will be onstage performing together for the 
entire show, so fans can enjoy the amazing entire show, so fans can enjoy the amazing 
chemistry and creativity that these two chemistry and creativity that these two 
musicians share with each other – and the musicians share with each other – and the 
audience. Catch the Blood Brothers Tour on audience. Catch the Blood Brothers Tour on 
the 17th at the Alberta Rose Theatre in the 17th at the Alberta Rose Theatre in 
Portland, the 18th at the Historic Everett Portland, the 18th at the Historic Everett 
Theatre in Everett, and on the 20th at the Theatre in Everett, and on the 20th at the 
Sunbanks Blues & Roots Festival in Electric Sunbanks Blues & Roots Festival in Electric 
City. City. 

TakeTake 6 6

Growing up, I preferred the Glimmer Growing up, I preferred the Glimmer 
Twins to the Beach Boys, but at last month’s Twins to the Beach Boys, but at last month’s 
Grammy Beach Boys Tribute, I enjoyed how Grammy Beach Boys Tribute, I enjoyed how 
Michael McDonald & the Take 6  updated Michael McDonald & the Take 6  updated 
“Don’t Worry Baby.”. Claude McKnight, Mark “Don’t Worry Baby.”. Claude McKnight, Mark 
Kibble, Joel Kibble, Dave Thomas, Alvin Kibble, Joel Kibble, Dave Thomas, Alvin 
Chea and Khristian Dentley have led Take 6 Chea and Khristian Dentley have led Take 6 
to 10 Grammy Awards, 10 Dove Awards, two to 10 Grammy Awards, 10 Dove Awards, two 
NAACP Image Awards, a Soul Train Award, NAACP Image Awards, a Soul Train Award, 
and more. Take 6’s Jazz Alley residency and more. Take 6’s Jazz Alley residency 
features six performances from May 18th to features six performances from May 18th to 
the 21st.the 21st.
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Backroads Blues Tour: Joe Bonamassa Backroads Blues Tour: Joe Bonamassa 
& Kenny Wayne Shepherd with Special & Kenny Wayne Shepherd with Special 
Guests Solomon Hicks & Bobby RushGuests Solomon Hicks & Bobby Rush

Blues rock icon and five-time Grammy-Blues rock icon and five-time Grammy-
nominated guitarist Kenny Wayne Shepherd nominated guitarist Kenny Wayne Shepherd 
has announced the second annual KWS has announced the second annual KWS 
Backroads Blues Festival, which will begin Backroads Blues Festival, which will begin 
with two performances in the Pacific with two performances in the Pacific 
Northwest featuring 25x Billboard chart-Northwest featuring 25x Billboard chart-
topper Joe Bonamassa, New York City-based topper Joe Bonamassa, New York City-based 
blues star King Solomon Hicks, and the blues star King Solomon Hicks, and the 
Grammy-award-winning blues artist Bobby Grammy-award-winning blues artist Bobby 
Rush. Rush. 

The festival starts at the Hayden Homes The festival starts at the Hayden Homes 
Amphitheater in Bend, Oregon, on Saturday, Amphitheater in Bend, Oregon, on Saturday, 
May 27th and rolls up to the Chateau May 27th and rolls up to the Chateau 
Ste. Michelle Winery in Woodinville, Ste. Michelle Winery in Woodinville, 
Washington on Sunday, May 28th. As of Washington on Sunday, May 28th. As of 
press time, additional dates include June 7th press time, additional dates include June 7th 
at the Rose Music Center at the Heights in at the Rose Music Center at the Heights in 
Huber Heights, Ohio and at the Yaamava’ Huber Heights, Ohio and at the Yaamava’ 
Theater, Highland, California with Ally Theater, Highland, California with Ally 

Venable and Eric Gales. Venable and Eric Gales. 

“I wanted to offer a traditional touring blues “I wanted to offer a traditional touring blues 
festival,” said  Shepherd. “One that will give festival,” said  Shepherd. “One that will give 
people a chance to see the best of the best all people a chance to see the best of the best all 
in one place.” The announcement follows a in one place.” The announcement follows a 
hugely successful inaugural run of the 2022 hugely successful inaugural run of the 2022 
Backroads Blues Festival, which featured Backroads Blues Festival, which featured 
Buddy Guy and Christone “Kingfish” Buddy Guy and Christone “Kingfish” 
Ingram. Ingram. 

“I’m really happy Joe and I were able to “I’m really happy Joe and I were able to 
work out our schedules to do these shows work out our schedules to do these shows 
together,” Shepherd continued. “And King together,” Shepherd continued. “And King 
Solomon Hicks is such a great talent, I’m Solomon Hicks is such a great talent, I’m 
thrilled he’s able to join us.”thrilled he’s able to join us.”

The Backroads Blues Festival is an extension The Backroads Blues Festival is an extension 
of Shepherd’s award-winning, Platinum-of Shepherd’s award-winning, Platinum-
selling selling 10 Days Out: Blues from the Backroads 10 Days Out: Blues from the Backroads 
film and album project, which saw him travel film and album project, which saw him travel 
the country with his band and a portable the country with his band and a portable 
studio alongside the world’s most renowned studio alongside the world’s most renowned 
blues players, as well as some of the genre’s blues players, as well as some of the genre’s 
lesser known, but rare and towering, talents. lesser known, but rare and towering, talents. 
Featured artists included EZ Baker, Pinetop Featured artists included EZ Baker, Pinetop 
Perkins, Honeyboy Edwards, Lazy Lester, Perkins, Honeyboy Edwards, Lazy Lester, 
Willie “Big Eyes” Smith, Hubert Sumlin, B.B. Willie “Big Eyes” Smith, Hubert Sumlin, B.B. 
King, among others.King, among others.

Remembering the B.B Kin Blues Festival Remembering the B.B Kin Blues Festival 
Tour, Shepherd recalled, “In the past, I really Tour, Shepherd recalled, “In the past, I really 
looked forward to those blues packages both looked forward to those blues packages both 
as a fan and as an artist, so I decided to bring as a fan and as an artist, so I decided to bring 
the concept back with the Backroads Blues the concept back with the Backroads Blues 

Festival. Those were very special shows, Festival. Those were very special shows, 
and once that ended, there was a void. Our and once that ended, there was a void. Our 
Backwoods Blues Festival Tour is firmly Backwoods Blues Festival Tour is firmly 
rooted in that same tradition.”rooted in that same tradition.”

“Really thrilled to be a part of these Backroads “Really thrilled to be a part of these Backroads 
Blues Festivals,” commented Bonamassa. Blues Festivals,” commented Bonamassa. 
“Anytime I can make music with my friends, “Anytime I can make music with my friends, 
and it all be on one bill is a real treat, not only and it all be on one bill is a real treat, not only 
for the fans but for me personally, as well.”for the fans but for me personally, as well.”

The announcement of the second annual The announcement of the second annual 
Backroads Blues Festival comes on the heels Backroads Blues Festival comes on the heels 
of Shepherd’s latest project of Shepherd’s latest project Trouble Is…25, Trouble Is…25, 
a top-to-bottom reinterpretation of his a top-to-bottom reinterpretation of his 
seminal album seminal album Trouble Is…Trouble Is…, which struck , which struck 
the match that reignited modern blues the match that reignited modern blues 
upon its release 25 years ago. The release is upon its release 25 years ago. The release is 
accompanied by a live DVD filmed at The accompanied by a live DVD filmed at The 
Strand Theatre in Shepherd’s hometown of Strand Theatre in Shepherd’s hometown of 
Shreveport, Louisiana, shot at the launch Shreveport, Louisiana, shot at the launch 
of his year-long celebration of the 25th of his year-long celebration of the 25th 
anniversary of anniversary of Trouble Is…,Trouble Is…, which found the  which found the 
band performing the album, in its entirety, band performing the album, in its entirety, 
across the US. Shepherd’s across the US. Shepherd’s Trouble Is…25 Trouble Is…25 
tour continues this spring and continues for tour continues this spring and continues for 
27 additional shows and starts 2024 aboard 27 additional shows and starts 2024 aboard 
the Legendary Rhythm and Blues Cruise the Legendary Rhythm and Blues Cruise 
out of Fort Lauderdale, Florida. For more out of Fort Lauderdale, Florida. For more 
information and to purchase tickets visit information and to purchase tickets visit 
kennywayneshepherd.net/tourkennywayneshepherd.net/tour
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Gospel in the NW: SONW choir sings America’s oldest roots music
The Sound of the Northwest spiritual choir season kicks off June 3 with new director

by Polly O’Kearyby Polly O’Keary, , editoreditor

Before blues, there was gospel and be-Before blues, there was gospel and be-
fore gospel there were spirituals and fore gospel there were spirituals and 
work songs. Sound of the Northwest, work songs. Sound of the Northwest, 
one of a handful of choirs in the nation one of a handful of choirs in the nation 
that focuses on those spirituals and work that focuses on those spirituals and work 
songs and the only of its kind in Seat-songs and the only of its kind in Seat-
tle, begins its performing season June 3 tle, begins its performing season June 3 
with new choir director Vanessa Bruce. with new choir director Vanessa Bruce. 

“The theme this year is ‘His Story, Her “The theme this year is ‘His Story, Her 
Story, Their Story: Different Perspectives,” Story, Their Story: Different Perspectives,” 
said Bruce, a music teacher with a degree said Bruce, a music teacher with a degree 
and education from Oberlin who moved and education from Oberlin who moved 
to the Northwest from the Midwest 25 to the Northwest from the Midwest 25 
years ago and who took the helm of the years ago and who took the helm of the 
organization in January. organization in January. 

The theme reflects the choir’s work to The theme reflects the choir’s work to 
preserve the music of early African preserve the music of early African 
and African-American composers who and African-American composers who 
committed their experiences to music. committed their experiences to music. 

“Their message and their hope can be “Their message and their hope can be 
applicable to people’s lives today,” said applicable to people’s lives today,” said 
Bruce. Bruce. 

When many of those songs were written, When many of those songs were written, 
they served different purposes than they they served different purposes than they 
do today. do today. 

Some were composed by slaves as a way to Some were composed by slaves as a way to 
pass the time while working. pass the time while working. 

“They would sing these songs to make the “They would sing these songs to make the 
day go by,” said Bruce. “They would sing day go by,” said Bruce. “They would sing 
‘This Old Hammer’ and they would smash ‘This Old Hammer’ and they would smash 
down the hammer during the rests.” down the hammer during the rests.” 

Other songs were more dangerous to sing. Other songs were more dangerous to sing. 
Some contained hidden messages about Some contained hidden messages about 
how to escape from slavery. Coded songs how to escape from slavery. Coded songs 
like “Deep River” and “Wade In the Water” like “Deep River” and “Wade In the Water” 
advised would-be escapees to flee through advised would-be escapees to flee through 
running water so search dogs couldn’t running water so search dogs couldn’t 
follow them by scent. follow them by scent. 

“You know the line ‘See that man all “You know the line ‘See that man all 
dressed in red,’” Bruce said, referring to dressed in red,’” Bruce said, referring to 
one of many interchangeable verses in the one of many interchangeable verses in the 
song “Wade in the Water.” “They would song “Wade in the Water.” “They would 

know to look for someone dressed in red. know to look for someone dressed in red. 
The verses changed based on the people The verses changed based on the people 
who helped.” who helped.” 

The song “Steal Away to Jesus” contains The song “Steal Away to Jesus” contains 
the lyric “My Lord he calls me, he calls the lyric “My Lord he calls me, he calls 
me by the thunder,” which meant that me by the thunder,” which meant that 
thunderstorms were a good time to escape. thunderstorms were a good time to escape. 
And a song called “Follow the Drinking And a song called “Follow the Drinking 
Gourd” referred to the African name for Gourd” referred to the African name for 
the Big Dipper constellation, advising the Big Dipper constellation, advising 
freedom-seekers to use the stars in the freedom-seekers to use the stars in the 
constellation to find their way to the north. constellation to find their way to the north. 
(Editor’s Note: There is a powerful version (Editor’s Note: There is a powerful version 
of Eric Bibb singing this on YouTube). of Eric Bibb singing this on YouTube). 

According to Bruce, many songs doubled According to Bruce, many songs doubled 
as religious songs and coded messages, as religious songs and coded messages, 
with heaven referring to the afterlife as well with heaven referring to the afterlife as well 
as to the places a person could live free.  as to the places a person could live free.  

Although much of the repertoire of SONW Although much of the repertoire of SONW 
harks from the 18th, 19th, and early 20th harks from the 18th, 19th, and early 20th 
centuries, the choir does perform more centuries, the choir does perform more 
contemporary works, including the works contemporary works, including the works 

of mid-century composer Moses Hogan and of mid-century composer Moses Hogan and 
current Indiana University professor and current Indiana University professor and 
Associate Director of the African American Associate Director of the African American 
Arts Institute Dr. Raymond Wise. Arts Institute Dr. Raymond Wise. 

“This year, we are featuring songs by female “This year, we are featuring songs by female 
composers,” Bruce said.  “That’s what we composers,” Bruce said.  “That’s what we 
mean by ‘His Story, Her Story, Their Story.’ mean by ‘His Story, Her Story, Their Story.’ 
I’ve been in choirs all my life, and most of I’ve been in choirs all my life, and most of 
the music was written by men, but you think the music was written by men, but you think 
about freedom songs and the things going about freedom songs and the things going 
on today, a lot of that music was written by on today, a lot of that music was written by 
women.” women.” 

One of the women whose music SONW One of the women whose music SONW 
performs is Seattle’s Cora Jackson, an performs is Seattle’s Cora Jackson, an 
educator who has written more than 200 educator who has written more than 200 
sings and three musical plays. Another is sings and three musical plays. Another is 
Bruce herself, whose song “Declaration of Bruce herself, whose song “Declaration of 
Trouble” addresses the failure of society Trouble” addresses the failure of society 
to extend the benefits of the Constitution to extend the benefits of the Constitution 
equally. One recently written song is “Say equally. One recently written song is “Say 
Her Name,” written for the victims of police Her Name,” written for the victims of police 
violence. violence. 

Vanessa Bruce, left, directs soloist Jacqueline Hardy and the Sounds of the Northwest Choir at the Vanessa Bruce, left, directs soloist Jacqueline Hardy and the Sounds of the Northwest Choir at the 
Phinney Ridge Lutheran Church March 25, 2023. The Sounds of the Northwest is one of just a handful of Phinney Ridge Lutheran Church March 25, 2023. The Sounds of the Northwest is one of just a handful of 

choirs in the US who perform traditional spirituals, many of which predate gospel music. choirs in the US who perform traditional spirituals, many of which predate gospel music. 

(Photo courtesy of Vanessa Bruce)(Photo courtesy of Vanessa Bruce)
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“It sounds like an African chant, like “It sounds like an African chant, like 
the weeping of women,” said Bruce. the weeping of women,” said Bruce. 
“In Africa and Asia, you can hear the “In Africa and Asia, you can hear the 
wailing of women when someone dies. wailing of women when someone dies. 
That song is a haunting song.”That song is a haunting song.”

SONW was begun in 1987 by the SONW was begun in 1987 by the 
internationally renowned choir internationally renowned choir 
director Juan Huey-Rey, whose death director Juan Huey-Rey, whose death 
in 2020 was marked by a motorcade in 2020 was marked by a motorcade 
through Seattle. Huey-Rey, who led through Seattle. Huey-Rey, who led 
the choir for 30 years, established the choir for 30 years, established 
the group’s ongoing commitment the group’s ongoing commitment 
to education and awareness, and to education and awareness, and 
performances still include information performances still include information 
about history and culture behind the about history and culture behind the 
music. music. 

Huey-Ray was followed by director Dr. Huey-Ray was followed by director Dr. 
Stephen Newby, who was followed in Stephen Newby, who was followed in 
turn by Vanessa Bruce. turn by Vanessa Bruce. 

Many of the choir’s performances are Many of the choir’s performances are 
geared toward audiences accustomed geared toward audiences accustomed 
to classical music, Bruce noted. to classical music, Bruce noted. 

“Audiences need to hear more than “Audiences need to hear more than 
Beethoven, Bach and Brahms,” she Beethoven, Bach and Brahms,” she 
said. “Yes, it’s beautiful and valid, but said. “Yes, it’s beautiful and valid, but 
we need to sing songs and perform we need to sing songs and perform 
songs that can lift the heart of our songs that can lift the heart of our 
audience. European music is well and audience. European music is well and 
good, but American music started good, but American music started 
with spirituals, so if we are educated with spirituals, so if we are educated 
musicians, we need to appreciate many musicians, we need to appreciate many 
different cultures.”different cultures.”

SONW is successful in that regard. SONW is successful in that regard. 
March 25, the choir presented a March 25, the choir presented a 

collaborative performance with the collaborative performance with the 
classical Northwest Chamber Chorus classical Northwest Chamber Chorus 
at Phinney Ridge Lutheran Church in at Phinney Ridge Lutheran Church in 
Seattle.Seattle.

“Some of the feedback we got from the “Some of the feedback we got from the 
audience was they were ecstatic, and audience was they were ecstatic, and 
they left feeling encouraged. it lifted they left feeling encouraged. it lifted 
them up,” Bruce said. “One lady said them up,” Bruce said. “One lady said 
she’d never left feeling so moved. She she’d never left feeling so moved. She 
ran out of words.” ran out of words.” 

These are stressful times for many These are stressful times for many 
people, Bruce observed. By performing people, Bruce observed. By performing 
the music of hope and strength that the music of hope and strength that 

sustained generations of people sustained generations of people 
struggling under oppression, SONW struggling under oppression, SONW 
offers an experience that can sustain offers an experience that can sustain 
people through trying days. people through trying days. 

People need some hope,” she said. People need some hope,” she said. 
“We want to encourage people to “We want to encourage people to 
persevere.”persevere.”

Sound of the Northwest’s Spring Sound of the Northwest’s Spring 
Concert will take place Sat., June 3, at Concert will take place Sat., June 3, at 
7 p.m. at Langston Hughes Performing 7 p.m. at Langston Hughes Performing 
Arts Institute, 104 17th Ave. South in Arts Institute, 104 17th Ave. South in 
Seattle. Learn more about the choir at Seattle. Learn more about the choir at 
www.thesonw.org. www.thesonw.org. 

Vanessa Bruce, director of the Sounds of the Northwest Choir, says this year’s choir repertoire will focus on Vanessa Bruce, director of the Sounds of the Northwest Choir, says this year’s choir repertoire will focus on 
songs composed by women. (Photo courtesy of Vanessa Bruce)songs composed by women. (Photo courtesy of Vanessa Bruce)
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Preview: Winthrop Rhythm & Blues Festival
“... thrilled to announce its 36th annual return to the Blues Ranch July 21-23...” “... thrilled to announce its 36th annual return to the Blues Ranch July 21-23...” 
Courtesy of the Winthrop Rhythm & Blues Courtesy of the Winthrop Rhythm & Blues 
FestivalFestival

“I even heard my own people say that “I even heard my own people say that 
young Black kids are not into blues young Black kids are not into blues 
music,” responds Christone “Kingfish” music,” responds Christone “Kingfish” 
Ingram – 2023 Winthrop Rhythm & Blues Ingram – 2023 Winthrop Rhythm & Blues 
Festival headliner – to an National Public Festival headliner – to an National Public 
Radio interviewer inquiring whether he’s Radio interviewer inquiring whether he’s 
considered his place in music. “I just want considered his place in music. “I just want 
to be the one to shatter the stereotype.”to be the one to shatter the stereotype.”

At just 24 years of age, Ingram has decidedly At just 24 years of age, Ingram has decidedly 
been doing some shattering. He played his been doing some shattering. He played his 
first “old-school style” juke joint at age 11 first “old-school style” juke joint at age 11 
and by the time he turned 18, Ingram – and by the time he turned 18, Ingram – 
hailing from the “Birthplace of the Blues,” hailing from the “Birthplace of the Blues,” 
Clarksdale, Mississippi – had already Clarksdale, Mississippi – had already 
toured the US and six other countries and toured the US and six other countries and 
performed at the White House for Michelle performed at the White House for Michelle 
Obama. His debut release, Obama. His debut release, KingfishKingfish (2019),  (2019), 
garnered a Grammy Nomination in the garnered a Grammy Nomination in the 
“Best Traditional Blues Album” category “Best Traditional Blues Album” category 
before he turned 21. “A stunning debut from before he turned 21. “A stunning debut from 
a young bluesman with an ancient soul and a young bluesman with an ancient soul and 
a large presence in the here-and-now” is a large presence in the here-and-now” is 
how how No DepressionNo Depression described it. Two years  described it. Two years 
later, Ingram’s second release, later, Ingram’s second release, 662,662, won a  won a 
Grammy Award for “Best Contemporary Grammy Award for “Best Contemporary 
Blues Album,” a collection Rock & Blues Blues Album,” a collection Rock & Blues 
Muse says “blows past all expectations.”Muse says “blows past all expectations.”

Winthrop Rhythm & Blues FestivalWinthrop Rhythm & Blues Festival – no  – no 
stranger to winning awards – is thrilled stranger to winning awards – is thrilled 
to announce its 36th Annual return to the to announce its 36th Annual return to the 
Blues Ranch July 21-23, featuring young Blues Ranch July 21-23, featuring young 
blues phenomenon Christone “Kingfish” blues phenomenon Christone “Kingfish” 
Ingram, New Orleans blue-eyed soul singer Ingram, New Orleans blue-eyed soul singer 
Marc Broussard, gospel-blues vocalist Marc Broussard, gospel-blues vocalist 
Ruthie Foster, the Grammy Award winning Ruthie Foster, the Grammy Award winning 
blues rockers North Mississippi Allstars, blues rockers North Mississippi Allstars, 
and more.and more.

Headliner and Headliner and blues guitar virtuosoblues guitar virtuoso  
Christone “Kingfish” Ingram Christone “Kingfish” Ingram is becoming is becoming 
the defining blues voice of his generation. the defining blues voice of his generation. 
NPR Music states:NPR Music states:  “Ingram plays guitar with “Ingram plays guitar with 
dramatic, searing tone and sure-handed dramatic, searing tone and sure-handed 
authority. And that’s just in the studio; he’s authority. And that’s just in the studio; he’s 
even scarier live.”even scarier live.”  

Christone “Kingfish” Ingram (Photo Courtesy of The 
Winthrop Rhythm & Blues Festival)

Ingram already has recording collaborations Ingram already has recording collaborations 
and shared stage time with musical icons and shared stage time with musical icons 
including Buddy Guy, Bootsy Collins, Gary including Buddy Guy, Bootsy Collins, Gary 
Clark, Jr., Keb’ Mo’, Robert Randolph, and Clark, Jr., Keb’ Mo’, Robert Randolph, and 
Brad Whitford (Aerosmith), as well as a Brad Whitford (Aerosmith), as well as a 
Grammy Award and Grammy Nomination Grammy Award and Grammy Nomination 
plus nine Blues Music Association awards. plus nine Blues Music Association awards. 
Get ready for a powerful, passionate Get ready for a powerful, passionate 
performance from an artist who Buddy Guy performance from an artist who Buddy Guy 
dubs “the next explosion of the blues.”dubs “the next explosion of the blues.”

North Mississippi All Stars (Photo Courtesy of the 
Winthrop Rhythm & Blues Festival)

“Profound organic Southern rocking groove” 
is how American Songwriter describes the 
Grammy Award-winning North Mississippi 
Allstars while AllMusic praises their latest re-
lease, Set Sail (2022), as being “as infectiously 
danceable as it is life affirming.” Anchored by 
brothers Luther and Cody Dickinson, sons of 
legendary Memphis producer Jim Dickinson, 
the band creates “modern Mississippi music 
inspired by the ancients and reaching into the 
future” (AllMusic) with an astonishing talent 
and range including Southern blues, rock, 
funk, and soul.

Ruthie Foster (Photo Courtesy of the Winthrop 
Rhythm & Blues Festival)

Four-time Grammy nominee Four-time Grammy nominee Ruthie FosterRuthie Foster  
is one of roots music’s great songwriters and is one of roots music’s great songwriters and 
voices, creating potent, soulful music with voices, creating potent, soulful music with 
a wide palette of American song forms, a wide palette of American song forms, 
from gospel and blues to jazz, folk and soul.from gospel and blues to jazz, folk and soul.  
Pop MattersPop Matters says of Foster:  says of Foster: “The singer will “The singer will 
take you to ‘Paradise’, or maybe it’s more take you to ‘Paradise’, or maybe it’s more 
accurate to say she’ll show you that you're accurate to say she’ll show you that you're 
already there.”already there.”

Mark Broussard (Photo Courtesy of the Winthrop 
Rhythm & Blues Festival)

Marc Broussard, Marc Broussard, a legendary Lafayette, a legendary Lafayette, 
Louisiana native and New Orleans star, Louisiana native and New Orleans star, 
channels his distinct “Bayou Soul” brand channels his distinct “Bayou Soul” brand 
– of funk, blues, R&B, rock, and pop, with – of funk, blues, R&B, rock, and pop, with 
distinct Southern roots – into a delightfully distinct Southern roots – into a delightfully 
deep and satisfying groove. deep and satisfying groove. No DepressionNo Depression  
states: “Broussard delivers in a fashion that’ll states: “Broussard delivers in a fashion that’ll 
seriously shake up your soul sensibilities, seriously shake up your soul sensibilities, 
old-school and new.”old-school and new.”
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Judith Hill (Photo Courtesy of the Winthrop 
Rhythm & Blues Festival)

Judith HillJudith Hill has a distinctive style described  has a distinctive style described 
alternately as soulful, earthy, powerful, and alternately as soulful, earthy, powerful, and 
beautiful, and is a thoughtful, Grammy beautiful, and is a thoughtful, Grammy 
Award-winning artist who moves easily Award-winning artist who moves easily 
from R&B to funk to hip-hop to jazz.from R&B to funk to hip-hop to jazz.  
Atwood MagazineAtwood Magazine: : ““Judith Hill’s voice is a Judith Hill’s voice is a 
sucker punch. It is powerful and raspy and sucker punch. It is powerful and raspy and 
beautiful and soulful and everything else that beautiful and soulful and everything else that 
comes with being a musician of her caliber. comes with being a musician of her caliber. 
It’s the kind of voice that rings out from a It’s the kind of voice that rings out from a 
stage and makes you stop in your tracks, set stage and makes you stop in your tracks, set 
down your drink, and listen.”down your drink, and listen.”

Eddie 9V 
(Photo by Charla Harvey)

Eddie 9VEddie 9V is an “unabashed soul-blues  is an “unabashed soul-blues 
revivalist who specializes in conjuring revivalist who specializes in conjuring 
the sounds of the 1960s, punctuating the sounds of the 1960s, punctuating 
his testifying with the steely sting of a his testifying with the steely sting of a 
Fender Esquire” (Fender Esquire” (AllMusic). Rolling StoneAllMusic). Rolling Stone  
proclaims, “This is a deeply American proclaims, “This is a deeply American 
sound, rich in tradition, and joyful to hear” sound, rich in tradition, and joyful to hear” 
while while Americana HighwaysAmericana Highways describes 9V’s  describes 9V’s 
music as “Gallons of soul, spiced up with music as “Gallons of soul, spiced up with 
charges of sax, snarky lead guitars, greasy charges of sax, snarky lead guitars, greasy 
burger bass, tight drums & a pinch of Dr. burger bass, tight drums & a pinch of Dr. 
John humid blues-funk.”John humid blues-funk.”

Rick Estrin & The Nightcats 
(Photo by Rachel Kumar)

Rick Estrin & the NightcatsRick Estrin & the Nightcats lay down one  lay down one 
of blues music’s best shows, a full-blast of blues music’s best shows, a full-blast 
performance with masterful storytelling. performance with masterful storytelling. 
DownBeatDownBeat says “Rick Estrin sings and  says “Rick Estrin sings and 
writes songs like the brightest wiseguy in all writes songs like the brightest wiseguy in all 
of bluesland and blows harmonica as if he of bluesland and blows harmonica as if he 
learned at the knee of Little Walter.”learned at the knee of Little Walter.”

Dwayne Dopsie 
(Photo Courtesy of the Artist) 

Grammy Award nominated Grammy Award nominated Dwayne Dwayne 
Dopsie & the Zydeco HellraisersDopsie & the Zydeco Hellraisers bring  bring 
sheer zydeco fun with the most dynamic sheer zydeco fun with the most dynamic 
and creative artists on the scene. From and creative artists on the scene. From 
Rolling Stone,Rolling Stone, “He has no competition in  “He has no competition in 
his genres, he's the Jimmy Hendrix of the his genres, he's the Jimmy Hendrix of the 
accordion.”accordion.”

Veronica Lewis (Photo Courtesy of the Winthrop 
Rhythm & Blues Festival)

Call it roots, call it the blues, call it what Call it roots, call it the blues, call it what 
you will, it’s 100% you will, it’s 100% Veronica LewisVeronica Lewis, who , who 
Pop MattersPop Matters calls “a virtuoso, and her record  calls “a virtuoso, and her record 
is custom-made for road trips, sock hops, is custom-made for road trips, sock hops, 
juke joints, and backyard picnics.”juke joints, and backyard picnics.”

Too Slim of Too Slim & The Taildraggers (Photo 
Courtesy of the Winthrop Rhythm & Blues Festival)

Straight whiskey blues with a southern Straight whiskey blues with a southern 
rock beer chaser sums up rock beer chaser sums up Too Slim & the Too Slim & the 
TaildraggersTaildraggers, and , and Blues Review Magazine Blues Review Magazine 
calls them “One of the finest original Blues calls them “One of the finest original Blues 
Rock trios performing today.”Rock trios performing today.”

(Continued on Page 22)(Continued on Page 22)
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    If you don’t know your googily 
moogily  from your wang dang doodle, 
join the Washington Blues Society

MEMBERSHIP HAS ITS PERKS!

Receive monthly Bluesletter in your mailbox*
Monthly All-Ages Blues Bash email notices
Member discounts for BB Awards and Holiday Party
10% off purchases at Silver Platters (any location)
10% discount at the Westport Inn (Westport, WA)
$1 off the cover and 25% off food at the Raging River Saloon (Fall City, WA)
$5 off the show admission for Friday 9:30 shows at Jazz Alley† 
And more! For the complete, most up-to-date list of membership benefits, visit wablues.org

SIGN UP  
ONLINE AT 
WABLUES.
ORG. OR,  
FILL OUT  
THE FORM  
BELOW &  
MAIL IT IN.

PLEASE CHECK ALL THAT ARE APPLICABLE. THANKS!

¨	 New	 ¨	 Renewal	 ¨	 Address Change

¨	 Individual Member $25

¨	 Couple $35

¨	 Band—First Member $25 	 ¨	 Band—Additional Member $20

¨	 Sponsorship—Gold $1,000	 ¨	 Sponsorship—Silver $600 	 ¨	 Sponsorship—Bronze $400

Name _____________________________________________________________________________________________

2nd Name (couple) _ _________________________________________________________________________________

Band Name (if applicable) _____________________________________________________________________________

Address _ __________________________________________________________________________________________

City _____________________________________________ 	 State _ _________________ 	 Zip ____________________

Phone ___________________________________________	 E-mail 	

Please tell us how you heard about the Washington Blues Society: ____________________________________________

I WOULD ALSO LIKE TO MAKE A TAX-DEDUCTIBLE CONTRIBUTION TO THE FOLLOWING FUNDS:

¨	 Musicians Relief Fund in the amount of $ _ ___________ 	providing assistance to local musicians in their time of need

¨	 Passing the Torch Fund in the amount of $ _ __________ 	educating the next generation of local musicians 

TOTAL ENCLOSED: $ ___________________________ . 	 Please send check or money order to	 WBS
	  	 PO BOX 70604
¨	 PLEASE CONTACT ME WITH VOLUNTEER OPPORTUNITIES	 SEATTLE, WA 98127	
	

* Due to postage fees, non-US residents will receive their Bluesletter electronically 
† With valid WBS membership card and advanced reservation. Reservations must be made by calling Jazz Alley at 206.441.9729 and re-

questing the WBS Special. This offer is not applicable to all shows.
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May 2023 Live Blues Music Calendar!May 2023 Live Blues Music Calendar!
Our website has the most up-to-date live music calendar & listings online @ www.wablues.org!Our website has the most up-to-date live music calendar & listings online @ www.wablues.org!

MAY 1
Madison Ave Pub, Everett: Mad Bojo 7 PM
Royal Room, Seattle: Royal Room Collective 7:30 PM
Blue Moon, Seattle: Andy Coe Band 9 PM

MAY 2
Capitol Cider, Seattle: John Pinetree Tuesday Blues 
Showcase 6:30 PM
Madison Ave Pub, Everett: Lee Howard 7 PM
Jazz Alley, Seattle: Billy Childs Quartet 7:30 PM 
Blue Moon, Seattle: Song Swap Meet 8 PM
Tim’s Tavern, White Center: Left Hand Smoke 8 PM
Billy Blues Bar, Vancouver: Ben Rice & The Hustle 
8 PM 

MAY 3
The Spar, Tacoma: Annie Eastwood Quartet 6 PM
CCR, Snohomish: The Usual Suspects 7 PM 
Jazz Alley, Seattle: Billy Childs Quartet 7:30 PM
Engel’s Pub, Edmonds: Dee’s Motown Jazz 8 PM

MAY 4
Slippery Pig, Poulsbo: Front St Blues Revue 7 PM
Madison Ave Pub, Everett: Kevin Sutton w/guests 
7 PM
Jazz Alley, Seattle: Spyro Gyra 7:30 PM

MAY 5
Engel’s Pub, Edmonds: Karlito & Squirrel 6 PM, 
Matlock & Keys  8 PM
Third Place Commons, Lake Forest Park: Honky 
Tonk Sweethearts 7 PM 
Black Angus, Puyallup: Max Renshaw 7 PM
Jazz Alley, Seattle: Spyro Gyra 7:30 PM
Tim’s Tavern, White Center: Andy Coe & Clinton 
Fearon 8 PM 
Mirkwood, Arlington: Dangerous Curves & Hot 
Flash 8 PM  

MAY 6
Paramount Theater, Seattle: DOORS: Opening 
Doors to the Arts Seattle Theatre Group's Annual 
Fundraiser & Online Auction! Mavis Staples w/
special guests 6 PM
Third Place Commons, Lake Forest Park: Yeti 
Chasers Swing 7 PM
Jazz Alley, Seattle: Spyro Gyra 7:30 PM
Grape and Grain, Everett: Norris & Nicely 7 PM
Brewminati, Prosser: Terry Robb Trio 7 PM
Rockfish, Anacortes: Joel Astley 7:30 PM
Engel’s Pub, Edmonds: Tim Turner 8 PM
Dawson’s, Tacoma: King Kon Beaux 8 PM
Doc’s Riverside, Snohomish: Nick Vigarino 8 PM

Conway Muse, Conway: Joe Cook Blues Band 8 PM

MAY 7
The Spar, Tacoma: Highway 16 Band 7 PM
Jazz Alley, Seattle: Spyro Gyra 7:30 PM
Peabo’s, Mill Creek: Peabo’s Sunday Music Revue 
8 PM
The Lime, Kirkland: Herding Cats 9 PM

MAY 8
Madison Ave Pub, Everett: Mad Bojo 7 PM
Royal Room, Seattle: Royal Room Collective 7:30 PM
Blue Moon, Seattle: Andy Coe Band 9 PM
The Central Saloon, Seattle: JP Falcon Band 8 PM 

MAY 9
Capitol Cider, Seattle: John Pinetree Tuesday Blues 
Showcase 6:30 PM
Aurora Borealis, Shoreline: Washington Blues 
Society Blues Bash w/Crushed Velvet & CC Adams 
Band 7 PM
Madison Ave Pub, Everett: Jill Newman & Margrett 
Wilder 7 PM
Jazz Alley, Seattle: Bill Charlap Trio 7:30 PM 
Tim’s Tavern, White Center: Big Kitty 8 PM
Engel’s Pub, Edmonds: John Case 8 PM
Billy Blues Bar, Vancouver: Ben Rice & The Hustle 
8 PM

MAY 10
The Spar, Tacoma: Velocity 6 PM
CCR, Snohomish: The Usual Suspects 7 PM
Rockfish, Anacortes: Newton’s Law 6 PM
Jazz Alley, Seattle: Bill Charlap Trio 7:30 PM 
Engel’s Pub, Edmonds: Sheri & da Boyz 8 PM

MAY 11
Slippery Pig, Poulsbo: Front St Blues Revue 7 PM
Madison Ave Pub, Everett: Kevin Sutton 7 PM
Jazz Alley, Seattle: Ottmar Liebert 7:30 PM

MAY 12
Third Place Commons, Lake Forest Park: Ranger & 
the Re-Arrangers 7 PM
Black Angus, Puyallup: Daniel Pellegrini 7 PM
Jazz Alley, Seattle: Ottmar Liebert 7:30 PM
Engel’s Pub, Edmonds: Fast Nasties 9 PM
Zola, Spokane: Justyn Priest 9 PM

MAY 13
The Repp, Snohomish: Norris & Nicely 6:30 PM
Madison Ave Pub, Everett: La Rocca Boom 7 PM
Bits, Mukilteo: Blue Healers 7 PM

Third Place Commons, Lake Forest Park: 24 
Madison 7 PM
Jazz Alley, Seattle:  Ottmar Liebert 7:30 PM
Historic Everett Theater, Everett: Peter Rivera w/
Toby Brady 7:30 PM
Stars Bar, Federal Way: CD Woodbury 8 PM
The Mill, Milton: King Kom Beaux 8pm
Engel’s Pub, Edmonds: Lone State 9pm

MAY 14 
The Spar, Tacoma: Blues Redemption w/Doug 
Skoog 7pm
Jazz Alley, Seattle: Ottmar Liebert 7:30 PM 
Peabo’s, Mill Creek: Peabo’s Sunday Music Revue 
8 PM 
The Lime, Kirkland: Herding Cats 9 PM

MAY 15
Madison Ave Pub, Everett: Mad Bojo 7 PM
Royal Room, Seattle: Royal Room Collective 7:30 PM
Blue Moon, Seattle: Andy Coe Band 9 PM

MAY 16
Capitol Cider, Seattle: John Pinetree Tuesday Blues 
Showcase 6:30 PM
Madison Ave Pub, Everett: JP Falcon w/David Tondi 
7 PM
Jazz Alley, Seattle: Veronica Swift 7:30 PM
Engel’s Pub, Edmonds: Dee’s Motown Jazz 8 PM
Billy Blues Bar, Vancouver: Ben Rice & The Hustle 
8 PM 

MAY 17
The Spar, Tacoma: Apollo Suns (Special Event) 6 PM
CCR, Snohomish: The Usual Suspects 7 PM
Jazz Alley, Seattle: Veronica Swift 7:30 PM 
Engel’s Pub, Edmonds: The Go 2’s 8 PM

MAY 18
Sunbanks, Electric City: Sunbanks Festival 5 PM
Madison Ave Pub, Everett: Kevin Sutton 7 PM
Slippery Pig, Poulsbo: Front Street Blues Revue 7 
PM
Jazz Alley, Seattle; Take 6 7:30 PM
The Historic Everett Theater, Everett: Blood 
Brothers w/Stacy Jones Band 7:30 PM

MAY 19
Sunbanks, Electric City: Sunbanks Festival 5 PM  
WIT Cellars, Prosser: Tyron Benoit Band 6 PM
Third Place Commons, Lake Forest Park: The 
Wayside 7 PM
Grape and Grain, Everett: Blue Healers 7 PM
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Jazz Alley, Seattle: Take 6 7:30 PM 
Engel’s Pub, Edmonds: Eric’s Maine Connection 9 
PM
Chan’s, Spokane: Justyn Priest 8 PM
Joseppi’s, Tacoma: Linda Carol & Retro Gruve 8 PM 

MAY 20
Sunbanks, Electric City: Sunbanks Festival 12 PM
Third Place Commons, Lake Forest Park: Moonlight 
Swing
Orchestra 7 PM
Madison Ave Pub, Everett: James Howard Band 7 
PM
Jazz Alley, Seattle: Take 6 7:30 PM
Historic Everett Theater, Everett: Jimmy Messina 
7:30 PM
Easy Monkey, Shoreline: Annie Eastwood All Star 
Band 8 PM
Conway Muse, Conway: Polly O’Keary & the Rhythm 
Method 8 PM
Engel’s Pub, Edmonds: Weatherheads 9 PM
219 Lounge, Sandpoint: Justyn Priest 9 PM 

MAY 21
Sunbanks, Electric City: Sunbanks Festival 12 PM
The Spar, Tacoma:  Joe T. Cook Band w/Tim 
Sherman 7 PM
Jazz Alley, Seattle: Take 6 7:30 PM 
Peabo’s, Mill Creek: Peabo’s Sunday Music Revue 
8 PM
The Lime, Kirkland: Herding Cats 9 PM

MAY 22
Madison Ave Pub, Everett: Mad Bojo 7 PM
Royal Room, Seattle: Royal Room Collective 7:30 PM
Blue Moon, Seattle: Andy Coe Band 9 PM 

MAY 23
Capitol Cider, Seattle: John Pinetree Tuesday Blues 
Showcase 6:30 PM
CCR, Snohomish: Washington Blues Society Blues 
Bash w/Brian Butler & The Cold 102’s 7 PM
Madison Ave Pub, Everett: Angelfire 7 PM
Jazz Alley, Seattle: Mathew Whitaker 7:30 PM 
Billy Blues Bar, Vancouver: Ben Rice & The Hustle 
8 PM

MAY 24
CCR, Snohomish: The Usual Suspects 7 PM
Jazz Alley, Seattle: Mathew Whitaker 7:30 PM 

MAY 25
Bad Albert’s, Seattle: Annie Eastwood & Friends 6 
PM

Madison Ave Pub, Everett: Stacy Jones w/guests 
7 PM
Slippery Pig, Poulsbo: Front St Blues Revue 7 PM
Jazz Alley, Seattle: Poncho Sanchez 7:30 PM
West of the Waterway, Tacoma: Lisa Mann’s 
Portland Blues Showcase 7:30 PM

MAY 26
Seattle Center, Northwest Folklife Festival 11 AM
Juan de Fuca Festival, Port Angelis 12 ON
Third Place Commons, Lake Forest Park: Fat Fridays 
7 PM
Jazz Alley, Seattle: Poncho Sanchez 7:30 PM
Aurora Borealis, Shoreline: CD Woodbury 8pm 
Pub 282 Camano Island: Annie Eastwood & All Star 
Band 8 PM

MAY 27
Seattle Center, Northwest Folklife Festival 11 AM
Juan de Fuca Festival, Port Angeles  12 PM  
Third Place Commons, Lake Forest Park: Seattle 
Solid Gold 7 PM
Madison Ave Pub, Everett: Joe Cook Band 7pm
Jazz Alley, Seattle: Poncho Sanchez 730pm

MAY 28
Seattle Center, Northwest Folklife Festival 11 AM
Juan de Fuca Festival, Port Angelis  12 PM 
Chateau Ste Michelle, Woodinville: Backroads 
Blues Festival 6 PM
The Spar, Tacoma:  Nick Vigarino 7 PM
Jazz Alley, Seattle: Poncho Sanchez 7:30 PM
Peabo’s, Mill Creek: Peabo’s Sunday Music Revue 
8 PM 
The Lime, Kirkland: Herding Cats 9 PM

MAY 29
Seattle Center, Northwest Folklife Festival 11 AM
Madison Ave Pub, Everett: Mad Bojo 7 PM
Royal Room, Seattle: Royal Room Collective 
7:30pm
Blue Moon, Seattle: Andy Coe Band 9 PM

MAY 30
Capitol Cider, Seattle: John Pinetree Tuesday Blues 
Showcase 6:30 PM
Madison Ave Pub, Everett: Unbound w/Kevin 
Sutton 7 PM
Purdy’s, Sumner: Tuesday Blues Showcase w/Joel 
Astley 7 PM
Jazz Alley, Seattle: Keyon Harrold 7:30 PM
Billy Blues Bar, Vancouver: Ben Rice & The Hustle 
8 PM 

MAY 31
CCR, Snohomish: The Usual Suspects 7 PM 
Jazz Alley, Seattle: Keyon Harrold 7:30 PM
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Preview: Winthrop Rhythm & Blues Festival (Continued)
“...  thrilled to announce its 36th annual return to the Blues Ranch July 21-23...”  thrilled to announce its 36th annual return to the Blues Ranch July 21-23...” 
(Continued from Page 17)(Continued from Page 17)

Yates McKendree 
(Photo by A. Scarlotti)

Grammy Award winner Grammy Award winner Yates McKendreeYates McKendree  
offers up searing guitar and silky-smooth offers up searing guitar and silky-smooth 
vocals from a legend-in-the-making. vocals from a legend-in-the-making. 
““Yates is proof of reincarnation”Yates is proof of reincarnation” claims Gary  claims Gary 
Nicholson, and continues:Nicholson, and continues: “Only a very old  “Only a very old 
and experienced soul could make his kind of and experienced soul could make his kind of 
art. Yes, he’s been around plenty before, and art. Yes, he’s been around plenty before, and 
he’s giving it to this world again, just getting he’s giving it to this world again, just getting 
started being timeless.started being timeless.

Stephanie Anne Johnson (Photo Courtesy of the Stephanie Anne Johnson (Photo Courtesy of the 
Winthrop Rhythm & Blues Festival)Winthrop Rhythm & Blues Festival)

Stephanie Anne JohnsonStephanie Anne Johnson  produces music produces music 
steeped in all that’s American, expressing steeped in all that’s American, expressing 
the pain of the past, the roots of the down the pain of the past, the roots of the down 
home, and the hope that hard work will home, and the hope that hard work will 
lead to proper reward.lead to proper reward.  Phantom Power Phantom Power 
MusicMusic observes of Johnson: “Every note,  observes of Johnson: “Every note, 
strum, word, groove – everything drips strum, word, groove – everything drips 
authenticity.”authenticity.”

Tevis Hodge, Jr.Tevis Hodge, Jr.
(Photo by Debra Penk)(Photo by Debra Penk)

Tevis Hodge JrTevis Hodge Jr, a solo semi-finalist in the , a solo semi-finalist in the 
2014 International Blues Challenge in 2014 International Blues Challenge in 
Memphis, harbors a deep love for Black Memphis, harbors a deep love for Black 
American music, and for bringing the American music, and for bringing the 
traditions of his heritage to life.traditions of his heritage to life.  “He’s got the “He’s got the 
right stuff,” says right stuff,” says TheCountryBlues.comTheCountryBlues.com, “and , “and 
more than a motherlode of talent!”more than a motherlode of talent!”

The Methow Juke Joint Allstars (Photo Courtesy of The Methow Juke Joint Allstars (Photo Courtesy of 
the Winthrop Rhythm & Blues Festival)the Winthrop Rhythm & Blues Festival)

Methow Juke Joint AllstarsMethow Juke Joint Allstars are a  are a 
collaboration of top musicians who make collaboration of top musicians who make 
the magic happen every night after the the magic happen every night after the 
show. show. American Blues SceneAmerican Blues Scene says of a  says of a Lady Lady 
AA release, “Standing on the shoulders of  release, “Standing on the shoulders of 
giants, Lady A delivers a thunderously giants, Lady A delivers a thunderously 
powerful new single” while powerful new single” while Blues in BritainBlues in Britain  
calls calls Polly O’Keary Polly O’Keary “a powerhouse blues/“a powerhouse blues/
rock singer whose voice has the resonance rock singer whose voice has the resonance 
and attitude that permeates her impressive and attitude that permeates her impressive 
bass playing.”bass playing.”

A beloved tradition for music fans from A beloved tradition for music fans from 
across the country and staple of the Pacific across the country and staple of the Pacific 
Northwest music scene, the Northwest music scene, the 36th Annual 36th Annual 
Winthrop Rhythm & Blues FestivalWinthrop Rhythm & Blues Festival  
promises to be outstanding, with promises to be outstanding, with 

its stunning natural setting in the Methow its stunning natural setting in the Methow 
Valley and a commitment to bringing the Valley and a commitment to bringing the 
best in blues, soul, zydeco, roots, and more. best in blues, soul, zydeco, roots, and more. 

In addition to the fantastic lineup, the In addition to the fantastic lineup, the 
festival will feature a wide range of local festival will feature a wide range of local 
food and craft booths and, with camping food and craft booths and, with camping 
available on-site, festivalgoers can truly available on-site, festivalgoers can truly 
immerse themselves in this uniquely immerse themselves in this uniquely 
intimate musical experience.intimate musical experience.  For Festival For Festival 
tickets, camping, and information, visit tickets, camping, and information, visit 
WinthropBluesFestival.com.WinthropBluesFestival.com.
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Blues Jams & Open Mic Listings
Jam hosts listed & open mics are either blues-friendly or full band-friendly. Go out & support live music!

SUNDAY
192 Brewing, Kenmore: All Ages 192 Blues Jam w/
The Groove Tramps 3-7 PM (Times Vary Seahawk 
Game Days)
Acorn Brewery, Edgewood: Blue Jam w/Retro Gruve 
The Bleu Note Restaurant & Lounge, Lakewood: 
Open Mic 6 PM
The Bennett Craft & Kitchen PoCo, Port Moody, 
B.C.: Sunday Blues Jam 3-7 PM
Bullhead Saloon, Four Lakes: Open Mic/Jam 5-8 PM
Captain Jacks, Sumner: Open Mic w/Lady Carter & 
the Gents 7 PM
Collector’s Choice Restaurant (CCR), Snohomish: 
Acoustic Open Mic 7 PM
Club Crow, Cashmere: Jam Session 1st Sun 7-10 PM
Conor Byrne, Seattle: Open Mic 8 PM
Darrell’s Tavern, Shoreline: Jazz Jam 7-10 PM
Dawson’s, Tacoma: Tim Hall Band 7-11 PM
The Boom Boom Rom at the Point Casino, 
Kingston: Duff’s Rockin’ Jam 7-10 PM
El Sarape Cantina, Shelton: Open Jam 3rd Sun 4 PM
Cafe Racer, Seattle: The Foundation Open Jam 4th 
Sun 7 PM
Headworks Brewery, Enumclaw: Open Mic 6 PM
Joseppi’s, Tacoma: Sunday Jam w/Mo Betta Band 
Lucky 7 Bar & Grill, Kirkland: Tommy Wall Blues Jam 
Mirkwood Public House, Arlington: Open Jam 7 PM
O’Malley’s Lounge, Olympia: Blues Jam w/The 
Pleasure Hounds 6-9 PM
Purdy’s, Sumner: Jerry Miller Blues Jam 7 PM
Queen Anne Beer Hall, Seattle: Open Mic 8 PM
Twin Dragon, Duvall: Open Jam w/Doug McGrew 
Red Dog Saloon, Maple Valley: Open Jam w/The 
Walkie Tacos 6 PM

MONDAY
Conor Byrne, Seattle: BlueGrass Acoustic Jam 8 PM
Nectar Lounge, Seattle: Mo Jam Mondays 9-11 PM
Royal Room, Seattle: Jazz Jam w/Thomas Marriott 
Badger Mountain Brewery, Wenatchee: North 
Central WA Blues Jam 1st, 3rd & 5th Mon 6 PM
Riverside Pub, Wenatchee: North Central 
Washington Blues Jam 2nd & 4th Mon 7-10 PM
Emerald of Siam, Richland: Open Mic/Band 
Showcase w/Barefoot Randy/Dirty River 
Entertainment 8 PM (All Ages until 10:45 PM)
HD’s Bar and Grill, Belfair: Joe Faker Jam 6 PM
Headworks Brewery, Enumclaw: Open Mic 6 PM

TUESDAY
Brother Don’s, Bremerton: All Ages Jam w/Tim Hall 
Band 7-10 PM
Café Racer, Seattle: Open Mic 1st & 3rd Tues 7 PM
Capitol Cider, Seattle: Tuesday Blues Jam w/John 
Pine Tree 6:30-8:30 PM
Royal Esquire Club, Seattle: Sea-Town All-Stars 8 PM
Elmer’s, Burien: Jam w/The Cory Wilds Band 8 PM
Engels Pub, Edmonds: Open Mic w/Dano Mac 8 PM

Antique Sandwich Co., Tacoma: Open Mic 7-10 PM
Double J Saloon, Lake City/ Seattle: Open Mic 1st & 
3rd Tues 8:30 PM
 Burien Eagles: Jam w/Billy Shew 7-11 PM
Grape and Grain, Everett: Acoustic Open Mic 6 PM
The Garages, Lake Oswego, OR: Garages Blues Jam 
w/The Pat Stillwell Band 7:30 PM
The Hidden Door, Shoreline: Open Mic 7 PM
Odin Brewery, Tacoma: Open Mic 7 PM
Oxford Saloon, Snohomish: Acoustic Open Mic w/
Jerry Battista 6 PM
Slippery Pig, Poulsbo: All Ages Open Mic 7 PM
Tweede’s Café, North Bend: Open Mic 6:30-9:30 PM
Zeek’s Pizza, Bellingham: Live Music  1st Tues 6-9 PM

WEDNESDAY
Acorn Brewery, Edgewood: Blues Jam 7 PM
Capitol Cider, Seattle: Jam Night 9 PM
Bethel Saloon, Port Orchard: Open Mic 8 PM
Black Dog Arts Cafe, Snoqualmie: All Ages Open 
Mic 7 PM
Black Lab Gallery, Everett: Open Mic w/ Jeff 
Crookall 6:30-10 PM
Blue Moon Tavern, Seattle: Open Mic 8-11 PM
Couth Buzzard Cafe, Seattle: Open Mic 7:30-10 PM
Stars Bar and Grill, Federal Way: Linda Myers 
Wicked Wednesday Jam 8-11 PM
Darrell’s Tavern, Shoreline: Open Mic 8:30-11 PM
Filling Station, Kingston: All Ages Open Mic All 
Styles & Instruments Welcome 7PM
The Hidden Door, Shoreline: Open Jam 7 PM
Jules Mae’s Saloon, Seattle: Jazz Open Mic 7 PM
Lake City Pub, Lakewood: Open Mic 7 PM
Madison Ave Pub, Everett: Unbound Blues Jam
Miller’s, Carnation: Open Mic Last Wed 6 PM
Mirkwood Public House, Arlington: One Take 
Weekly Jam w/Chris Eger &Richard Williams 8-11 PM
Penn Cove Brewing Company, Coupeville: Open 
Mic 6 PM
Skylark Café, West Seattle: Open Mic 8-11 PM
Soundbite Cider, Everett: Open Mic 7 PM
Stockton’s, Maple Valley: Jam Night w/Billy Shew 
Tony V’s Garage, Everett: Open Mic 9-11 PM
The Tin Hat, Kennewick: Open Mic & Jam w/The 
Mondo Ray Band 7-11 PM
Brickhouse, Vancouver, WA: Open Mic w/Right as 
Rain Entertainment 8:30 PM
Whit’s End, Seattle: All Ages Open Mic 2nd & 4th 
Thurs 8 PM

THURSDAY
192 Brewing Company, Kenmore: Open Mic 7 PM
Bent Bine Brew Co., Belfair: Open Mic 6 PM
Bearded Monkey Music, Yakima: Open Mic 6:30 PM
The Blue Room, Bellingham: All Ages Open Mic 
Bushell & Barrel Cider House, Poulsbo: Open Mic
Cruisers, Post Falls, ID: Open Mic/Jam Night 6 PM

Pt Gardner Bay Winery, Everett: Open Mic 6:30 PM
Dawson’s, Tacoma: Blues Jam w/Billy the Pocket 
Dog House, Seattle: Jam w/The Uptown All Stars
Flight Path, Burien: Open Mic Jam Night 8:30 PM
The Growler Guys, Lake City, Seattle: Jazz Open Mic
Jack-sons Sports Bar & Clubhouse, Yakima: Open 
Jam 8 PM
Kimball Coffee House, Gig Harbor: All Ages Open 
Mic, 5:30 PM
Looking Glass Coffee, Snohomish: Open Mic 2nd & 
4th Thurs 7PM
Lucky 7 Bar & Grill, Kirkland: Pro Jam 8 PM
The Village Inn Pub, Bellingham: Jam w/Jimmy D
Salmon Bay Eagles, Seattle: Blues Jam Last Thurs
Slippery Pig Brewery, Poulsbo: All Ages Front St 
Blues Review Night w/Thys Wallwork 7 PM
Gordon & Purdy’s Pub, Sumner: Outlaw Blues Jam 
w/Boogie Chillin’ 7 PM
Stars Bar & Grill, Federal Way: Jam Night w/Billy 
Shew 8 PM
The New Moon Craft Tavern, Pt Angeles: Blues Jam 
New Frontier Lounge, Tacoma: Open Mic w/ Chuck 
Muller 7 PM
The Spot, West Seattle: Blues Night 6 PM
San Juan Island Brewing Co., Friday Harbor: Open 
Mic 6 PM
Station 18, Seattle: Jazz Jam w/Kevin McCarthy Trio 
7 PM (All Ages until 10 PM)
Red Dog Saloon, Maple Valley: Open Jam w/The 
Iron Stallion Band 7 PM
The Loft Pub, Victoria B.C.: Open Jam 7-11 PM
Maverick’s, Lakeside, MT: Blues Jam Thurs 8:30 PM
The Valley, Tacoma: Open Mic w/Elizabeth 
Ashbrook 8 PM
Thirsty Badger, Lynden: Open Mic 7-11 PM

FRIDAY
Bryant Corner Cafe, Seattle: Open Mic 6:30 PM
La Copa Café, Seattle: All Ages Victory Music Open 
Mic 6:30-9 PM
Dreadknott Brewery, Monroe: Open Mic 7-10 PM
Kana Winery, Yakima: Open Mic 7-10 PM
Wicked Cider, Kennewick: Wicked Jamz/Open Mic 
Every Other Fri 6-10 PM

SATURDAY
The Spot, West Seattle: Open Mic 6 PM
The Hidden Door, Shoreline: Open Mic 7 PM
Kiss the Sky Books, Sultan: Open Mic 7PM

PLEASE CONTACT THE VENUE WITH 
QUESTIONS ABOUT THEIR BLUES JAM 
OR OPEN MIC  (START TIME, ALL-AGES, 

ETC). THANK YOU! 
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By Sanya Khanna, University of By Sanya Khanna, University of 
Washington Washington 

A century ago, a person of any color could arrive A century ago, a person of any color could arrive 
in nearly any major American city and ask for in nearly any major American city and ask for 
directions to the local black and tan club. Such directions to the local black and tan club. Such 
clubs flourished as places where races could clubs flourished as places where races could 
mingle to listen to live music, dance, and drink, mingle to listen to live music, dance, and drink, 
in many cases even during prohibition. Seattle’s in many cases even during prohibition. Seattle’s 
version was literally called the Black and Tan version was literally called the Black and Tan 
Club, and it operated on 12th and Jackson, in Club, and it operated on 12th and Jackson, in 
the basement of a Japanese drugstore, where it the basement of a Japanese drugstore, where it 
was a leading blues nightclub in Seattle from the was a leading blues nightclub in Seattle from the 
1920s through 1960s.1920s through 1960s.

A new version of the club will come to life with A new version of the club will come to life with 
a reopening later this year as the Black & Tan a reopening later this year as the Black & Tan 
Hall. Although at a different location, it will Hall. Although at a different location, it will 
preserve the tradition of being a place where preserve the tradition of being a place where 
all people are welcome to eat, drink, and enjoy all people are welcome to eat, drink, and enjoy 
entertainment. Live music including blues and entertainment. Live music including blues and 
jazz and hip hop will be an important part of  jazz and hip hop will be an important part of  
the club’s offerings, as will other performing arts, the club’s offerings, as will other performing arts, 
including poetry readings and more. including poetry readings and more. 

Benjamin Hunter, a co-founder of the Black and Benjamin Hunter, a co-founder of the Black and 
Tan Hall. said the Hall has taken the name of the Tan Hall. said the Hall has taken the name of the 
historic club because, although legal separation historic club because, although legal separation 
of races is no longer institutionalized, people of races is no longer institutionalized, people 
still tend to spend time almost entirely with still tend to spend time almost entirely with 
those of their own demographic. those of their own demographic. 

“The history of the Black & Tan Club was that “The history of the Black & Tan Club was that 
it was always an integrated place, a place that it was always an integrated place, a place that 
addresses segregation,” he said. “Only now it’s addresses segregation,” he said. “Only now it’s 
social segregation.”social segregation.”

Originally called theAlhambra Cabaret, the Originally called theAlhambra Cabaret, the 
club’s name was later changed to the Black & Tan club’s name was later changed to the Black & Tan 

as a nod to the racially diverse as a nod to the racially diverse 
clientele, which included clientele, which included 
rican-Americans, Caucasians, rican-Americans, Caucasians, 
Asians and people of mixed Asians and people of mixed 
heritage.heritage.

From 1922 until about 1966, From 1922 until about 1966, 
the Black & Tan Club was at the Black & Tan Club was at 
the heart of Seattle’s nightlife the heart of Seattle’s nightlife 
andpromoted the popularity andpromoted the popularity 
of jazz and later blues in the of jazz and later blues in the 
city. Even during Prohibition, city. Even during Prohibition, 
the club remained a prime the club remained a prime 
hangout spot. The Club was hangout spot. The Club was 
eventually asked to close after eventually asked to close after 
repeated raids by the Liquor repeated raids by the Liquor 
Control Board, but it was Control Board, but it was 
able to continue operating as able to continue operating as 
a “members-only” in order to dodge scrutiny, a a “members-only” in order to dodge scrutiny, a 
common tactic used by clubs at the time.common tactic used by clubs at the time.

The club’s new location in Hillman City, near The club’s new location in Hillman City, near 
the intersections of Rainier and Orcas, was the intersections of Rainier and Orcas, was 
chosen because its earlier location, once the chosen because its earlier location, once the 
heart of Black Seattle, is becoming prohibitively heart of Black Seattle, is becoming prohibitively 
expensive as its cache has grown. This has expensive as its cache has grown. This has 
resulted in a 60% reduction in the Black resulted in a 60% reduction in the Black 
population in the last decade.population in the last decade.

While Hillman City may eventually face the While Hillman City may eventually face the 
same changes, currently it is home to many of same changes, currently it is home to many of 
Seattle’s people of color, including most of the Seattle’s people of color, including most of the 
nonprofit Hall’s 25 co-owners. nonprofit Hall’s 25 co-owners. 

“Where the existing building is now is kind on “Where the existing building is now is kind on 
the breaking wave of gentrification,” said Joe the breaking wave of gentrification,” said Joe 
Seamons, a leading organizer and one of the co-Seamons, a leading organizer and one of the co-
owners. “That’s one of the reasons we are focused owners. “That’s one of the reasons we are focused 
on Hilllman City. The majority of owners are on Hilllman City. The majority of owners are 

people of color and live within a mile of people of color and live within a mile of 
the business.”the business.”

The Hall’s mission is to sustain a thriving The Hall’s mission is to sustain a thriving 
and equitable economy through arts and and equitable economy through arts and 
cultural programming, said Seamons, cultural programming, said Seamons, 
who works on designing and overseeing who works on designing and overseeing 
the various training programs and the the various training programs and the 
general setup for the hall’s activities. The general setup for the hall’s activities. The 
Hall will also work to strengthen the Hall will also work to strengthen the 
community and its network of Black-community and its network of Black-
owned and Black-led spaces.owned and Black-led spaces.

The building’s renovation will preserve part of The building’s renovation will preserve part of 
Seattle’s architectural history. Seattle’s architectural history. 

“It’s a 100-year-old movie theater, for most of its “It’s a 100-year-old movie theater, for most of its 
life if it was a Japanese movie theater,” Seamons life if it was a Japanese movie theater,” Seamons 
said. “It’s a well-made hall, 30 feet wide, and the said. “It’s a well-made hall, 30 feet wide, and the 
cool part is that it’s built of timbers milled right cool part is that it’s built of timbers milled right 
there in the Rainier Valley.” there in the Rainier Valley.” 

The nonprofit organization that owns the The nonprofit organization that owns the 
venue raised $1 million to buy the building venue raised $1 million to buy the building 
after negotiations to lease broke down, and after negotiations to lease broke down, and 
then another $1 million to renovate. Seamons then another $1 million to renovate. Seamons 
and others had hoped to open months ago, but and others had hoped to open months ago, but 
COVID slowed the project. Now Seamons said COVID slowed the project. Now Seamons said 
the goal is to open by the end of the year.	the goal is to open by the end of the year.	

Black and Tan Hall to revive the spirit of Seattle’s earliest integrated music venue
Slowed by the COVID crisis, the nonprofit arts venue is on track to open by the end of the yearSlowed by the COVID crisis, the nonprofit arts venue is on track to open by the end of the year

B&TH partner Karen Toering cleans up the stage post-renovation. The new 
artworks on the wall are by Walter Peeze. Photo credit: Marcus Warlick.

Several of the Black and Tan Hall’s 25 partners celebrate their 
progress at a block party last summer. The venue is on track to open 
around the end of the year. Photo credit: Jovelle Tamayo
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You Should Have Been There
Kim Field’s Harmonica ShowcaseKim Field’s Harmonica Showcase

By Bear DruryBy Bear Drury

Reverend Dave Brown has done it again. On Reverend Dave Brown has done it again. On 
March 23, in The Spanish Ballroom at McMe-March 23, in The Spanish Ballroom at McMe-
namins Elks Temple in Tacoma, he presented namins Elks Temple in Tacoma, he presented 
another fabulous harmonica showcase hosted another fabulous harmonica showcase hosted 
by the great Kim Field featuring the best har-by the great Kim Field featuring the best har-
monica artists from the Puget Sound area. It was monica artists from the Puget Sound area. It was 
a beautiful venue for such a soul stirring event.a beautiful venue for such a soul stirring event.

Backed by a rock-solid trio featuring wildman Backed by a rock-solid trio featuring wildman 
Tim Sherman on guitar, groovin’ Les White on Tim Sherman on guitar, groovin’ Les White on 
bass, and boppin’ David Hudson on drums, the bass, and boppin’ David Hudson on drums, the 
harmonica players gave a master class of how harmonica players gave a master class of how 
versatile the simple “tin sandwich” can be.versatile the simple “tin sandwich” can be.

The show started with three numbers from Joe The show started with three numbers from Joe 
Cook. Joe wasted no time in showing us why Cook. Joe wasted no time in showing us why 
The Joe Cook Band is in such demand all over The Joe Cook Band is in such demand all over 
the area. Run, don’t walk to their next show in the area. Run, don’t walk to their next show in 
your area. You will not be disappointed.your area. You will not be disappointed.

Kim Field took the stage next, and his three Kim Field took the stage next, and his three 
songs once again proved that even though he songs once again proved that even though he 
has moved to Portland, his legacy in the Seattle has moved to Portland, his legacy in the Seattle 
area will never be forgotten. He is certainly one area will never be forgotten. He is certainly one 
of the finest of all time.of the finest of all time.

Joel Astley perfectly illustrated that the future Joel Astley perfectly illustrated that the future 
of blues harmonica is in good hands. Through of blues harmonica is in good hands. Through 
his excellent song writing and playing skills this his excellent song writing and playing skills this 
young man is carrying the torch into the future. young man is carrying the torch into the future. 
His star is still on the rise. We are truly privileged His star is still on the rise. We are truly privileged 
to have him among us.to have him among us.

And then...there was the master himself, Mr. And then...there was the master himself, Mr. 
Mark DuFresne, a living legend if there ever Mark DuFresne, a living legend if there ever 
was one. Mere words cannot express the impact was one. Mere words cannot express the impact 
this man’s performances can have on the human this man’s performances can have on the human 
soul. His voice is incomparable. His harmonica soul. His voice is incomparable. His harmonica 
prowess is otherworldly.prowess is otherworldly.

After a brief intermission each artist returned After a brief intermission each artist returned 
to perform two more numbers. And if you to perform two more numbers. And if you 
thought their first round was hot the second act thought their first round was hot the second act 
was on fire! But just when you though it couldn’t was on fire! But just when you though it couldn’t 
get any hotter, they kicked in the afterburners get any hotter, they kicked in the afterburners 
for the grand finale.for the grand finale.

With all four masters on stage, Kim counted off With all four masters on stage, Kim counted off 
an unrehearsed rendition of the Junior Wells an unrehearsed rendition of the Junior Wells 
classic “Little By Little (I’m Losing You)”. Ev-classic “Little By Little (I’m Losing You)”. Ev-
eryone jumped in and took turns singing and eryone jumped in and took turns singing and 
playing. It was absolutely glorious! It literally left playing. It was absolutely glorious! It literally left 
the audience breathless. It was a perfect ending the audience breathless. It was a perfect ending 
to a wonderful evening.to a wonderful evening.

In addition to his famous Blues Vespers, Rever-In addition to his famous Blues Vespers, Rever-
end Dave Brown joins forces with Kim Field to end Dave Brown joins forces with Kim Field to 
host these magical events several times a year. host these magical events several times a year. 
Please attend every chance you get. Please attend every chance you get. 

You should have been there.You should have been there.

Above, left to right: Joel Astley, Tim Sherman, Joe Cook, Rev. Dave Brown, Kim Field, Mark DuFresne, 
David Hudson, Les White
Below, left to right: Tim Sherman, Kim Field, David Hudson, Joe Cook, Joel Astley, Les White, Mark 
DuFresne. Photos by Bear Drury.
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Whom to Hire, Get in Touch
Send updates, additions & corrections to both Editor@wablues.org and ericrichd@aol.com by the 10th! 
$
$cratch Daddy (425) 210-1925

#
44th Street Blues Band �206.714.5180 or 
206.775.2762

A
A.H.L. �206.935.4592
Al Earick Band �253.278.0330
Albritten McClain & Bridge of Souls �206.650.8254
Alice Stuart & the Formerlys �360.753.8949
AlleyKatz �425.273.4172
ALTAI BAND �goldenguitarman777@gmail.com, 
galiawind@yahoo.com  
Amigos Nobles 425.268.7064
Andrew Norsworthy �andrewnorsworthy@yahoo.com
Andy Koch’s Badd Dog Blues (formerly Badd Dog 
Blues Society) �360.739.6397
Annette Taborn �206.306.3398
Annieville Blues �206.994.9413
Author Unknown �206.355.5952

B
Baby Cakes 206.818.0588
Baby Gramps Trio �425.483.2835
Back Porch Blues �425.299.0468
Backwoods Still �425.330.0702
Badd Dog Blues Society �360.733.7464
Barry Torrence 253.226.1103
Bay Street Blues Band �360.731.1975
B.E.S.T. Band �206.817.1663
Bill Brown & The Kingbees �206.276.6600
Bill Ray Drums 760 803 1686
Billy Barner �253.732.0618
Billy Shew Band �253.514.3637
Billy Stapleton 425.478.2113
Black River Blues �206.396.1563
Blackjack Kerouac 206.697.8428
Blackstone Players �425.327.0018
Blue 55 �206.216.0554
Blue Healers �206.940.9128
Blues on Tap �206.618.6210
Blues Playground �425.359.3755
Blues Redemption �253.253.921.7506
Blues Sheriff �206.979.0666
Blues To Do Monthly �206.328.0662
Blues with Benefits 206.459.3278
Bobby Holland & The Breadline �425.681.5644
Boneyard Preachers �206.755.0766 or 206.547.1772
Bobby Patterson & the Two Tones 509.869.0350.
Brian Butler Band �206.361.9625

Brian Hurst �360.708.1653
Brian Lee & The Orbiters �206.390.2408
Bruce Govan �206.817.1663
Bruce Koenigsberg / Fabulous Roof Shakers 
�425.766.7253
Bruce Ransom �206.618.6210
Bump Kitchen �253.223.4333 or 360.259.1545

C
C.D. Woodbury Band �425.502.1917
CC Adams Band �360.395.8540
Charles White Revue �425.327.0018
Charlie Butts & The Filtertips �509.655.1071
Charlie Saibel �360.357.8553
Chester Dennis Jones �253.797.8937
Children Of The Blues  818.292.2541
Chris Eger Band �360.770.7929
Chris Lord �425.334.5053
Chris Stevens’ Surf Monkeys �206.236.0412
Coyote Blues �360.420.2535
Craig Parrish/Margaret Wilder Band 360.380.2250
Crooked Mile Blues Band �425.238.8548
Curtis Hammond Band �206.696.6134
Cyndi Moring and Lucile Street 206.849.8471

D
Daddy Treetops �206.601.1769
Dan & the Dynos 206.225.9684
Dana Lupinacci Band �206.860.4961
Dave Albert 425.269-3665Dave Albert 425.269-3665
Dave Townsend (Midnight Hour) 425.238.4039Dave Townsend (Midnight Hour) 425.238.4039
David Hudson / Satellite 4 �253.630.5276
Dennis “Juxtamuse” Hacker �509.264.7879
Dick Powell Band �425.742.4108
Don Bird 818.292.2541
Doug McGrew �206.679.2655
Doug Skoog �253.921.7506
Dudley Taft �513.713.6800

E
El Colonel �360.293.7931
Elliott Bay Blues Band �206.300.6802
Ellis Carter �206.935.3188
Eric Madis & Blue Madness �206.251.0339
Eric’s Maine Connection 425.299.7496
Eric Rice 425.299.7496

F
Fat Cat �425.487.6139
Filé Gumbo �425.788.2776

G
Gary Frazier �206.851.1169
Greg Roberts �206.473.0659
Groove Tramps �720.232.9664
Guilded Lily Band 915.222.6401
Gunnar Roads �360.828.1210

H
Hambone Blues Band �360.458.5659
Hambone Wilson �360.739.7740
Heather & the Nearly Homeless Blues Band 
�425.576.5673
High Note Group 206.214.7977
Hot Mess Duo �206.214.7977
Hot Wired Rhythm Band �206.790.9935
Hungry Dogs �425.299.6435

J
Jack Cook & Phantoms of Soul �206.517.5294
James Howard �206.250.7494
James King & the Southsiders �206.715.6511
Janie Cribbs & the T.Rust Band �360.331.6485
JD Hobson �206.235.3234
Jeff Boutiea & the Blues Choo Train �425.345.5399
Jeff “Drummerboy” Hayes �206.909.6366
Jeff & The Jet City Fliers �206.818.0701
Jeff Menteer and The Beaten Path �425.280.7392
Jeremy Serwer �520.275.9444
Jesse Weston �425.610.0933
Jill Newman Band �206.390.2623
James Brunner 509.457.0762James Brunner 509.457.0762
Jim Caroompas (Rumpus) �925.212.7760
Jim McLaughlin �425.737.4277
Jim Nardo Blues Band �360.779.4300
Jimmy Free’s Friends �206.546.3733
Joe Blue & the Roof Shakers �425.766.7253
Joe Cook Blues Band �206.547.1772
Joe Guimond �509.423.0032
Joel Astley �206.214.7977
John “Scooch” Cugno’s Delta 88 Revival 
�360.352.3735
John “Greyhound” Maxwell 360.685.6006
John Stephan Band �206.244.0498
John Stephanus 206.459.3278
Jolene Gayle 509.433.4944
JP Hennessy �425.273.4932
Julia Francis & the Secrets of Soul �206.618.4919
Julie Duke Band �206.459.0860
Junkyard Jane �253.238.7908
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K
K. G. Jackson & The Shakers �360.896.4175
Keith Nordquist �253.639.3206
Keith Scott 773.213.3239
Kenny James Miller Band 406.253.7439
Kevin & Casey Sutton �314.479.0752
Kid Quagmire �206.412.8212
Kim Archer Band �253.298.5961
Kim Field & The Mighty Titans of Tone �206.295.8306
Kimball Conant & The Fugitives �206.938.6096
King Kom Beaux 253.732.0618
Kosta Panidis (Kosta la Vista) �509.991.7623

L
La Roca Boom 206.920.6776
Lady “A” & The Baby Blues Funk Band �425.518.9100
Larry Hill �206.696.1789
Leanne Trevalyan �253.238.7908
Lee Oskar & Friends 425.258.3585
Leo Muller �206.300.6802
Linda Carroll & Retro Gruve 253.606.1500.
Little Bill & the Bluenotes �425.774.7503
Lori Hardman Band 425.218.5341
Lucille Street �cynmoring@gmail.com

M
Madison Ave Blues Revue MAD BOJO 425-422-5062
Maia Santell & House Blend �253.983.7071
Margret Wilder Band (360) 380-2250
Mark A. Noftsger �425.238.3664
Mark Hurwitz & Gin Creek �206.588.1924
Mark Riley �206.313.7849
Marty Vadalabene 206.914.3026
Mary Ellen Lykins Band �360.395.8540
Mary McPage �206.850.4849
Michael “Papa Bax” Baxter �425.478.1365
Michael Wilde �425.672.3206 or 206.200.3363
Michal Miller Band �253.222.2538
Michelle D’Amour and The Love Dealers 
�425.761.3033
Midnight Hour 425.238.4039
Mike Haley �509.393.5838
Miles from Chicago �206.440.8016
Miles Harris 360.708.2166
Mitch Pumpian 206.276.9737
Monster Road Band  (253) 797-9503
Moon Daddy Band �425.923.9081
Mule Kick �216.225.1277

N
New Rhythmatics  425.299.3028
Nick Vigarino �360.387.0374
Nick Mardon Trio  425.208-6616
Nancy Veltkamp 915.222.6401
Norm Bellas & the Funkstars �206.722.6551

P
Paul Green �206.795.3694
Phil Mitchell (425)870-5018Phil Mitchell (425)870-5018
Polly O’Keary & The Rhythm Method �206.384.0234
Porterhouse Blues Band 425.381.7649
Powerhouse 425.478.2113

R
Rafael Tranquilino Band �312.953.7808
Randy Norris & Jeff Nicely �425.239.3876 or 
425.359.3755
Randy Norris & The Full Degree �425.239.3876
Randy Oxford Band �253.973.9024
Raven Humphres �425.308.3752
The Rece Jay Band (253) 350-9137
Red House �425.377.8097
Reggie Miles �360.793.9577
Reji Marc (206) 486-0386
Richard Allen & The Louisiana Experience 
�206.369.8114
Richard Evans �206.799.4856
Right Hand Drive �206.496.2419
RJ Knapp & Honey Robin Band �206.612.9145
Rob Moitoza 206.401.2856
Robert Baker  425.870.7683
Robert Patterson �509.869.0350
Robert and Randolph Duo 509.216.0944
Rod Cook & Toast �206.878.7910
Roger Rogers Band �206.255.6427
Ron Hendee �425.280.3994
Roxlide �360.881.0003
Russ Kammerer �206.551.0152
Rusty Williams �206.282.0877

S
Sammy Eubanks �509.879.0340
Scott E. Lind �206.789.8002
Scott Mallard 206.261.4669
Scotty FM and the BroadCasters 206.261.4669
Scotty Harris �206.683.9476
Shadow Creek Project �360.826.4068
Sheri Roberts Greimes �425.220.6474
Smokin’ J’s �425.746.8186
Son Jack Jr. �425.591.3034
Spencer Jarrett �510.495.4755
Stacy Jones �206.992.3285
Star Drums & Lady Keys �206.522.2779
Steve Bailey & The Blue Flames �206.779.7466

Steve Cooley & Dangerfields �253.203.8267
Steve Peterson 206.799-8196Steve Peterson 206.799-8196
Steven J. Lefebvre �509.972.2683 or 509.654.3075
Stickshift Annie Eastwood �206.941.9186
Studio Rob 425.870.7683
Susan Renee’ “La Roca Soul” Sims �206.920.6776
Suze Sims �206.920.6776

T
TJ Read 206.380.6638TJ Read 206.380.6638
Tamys Hoffman Band 406.570-2303Tamys Hoffman Band 406.570-2303
Terraplane Band (425)870-5018(425)870-5018
Terry Hartness �425.931.5755
The 509s 509.423.0032
The Bret Welty Band �208.703.2097
The EveryLeaf Band �425.369.4588
The Fabulous MoJo Kings �206.412.9503
The Jelly Rollers �206.617.2384
The Mongrels �509.307.0517 or 509.654.3075
The Nate Burch Band �425.457.3506
The Naughty Blokes �360.393.9619
The Pat Stilwell Band 503.481.6823
The Rece Jay Band �253.350.9137
The RooTsters (Acoustic Duo) 206.890.6176
The Soulful 88s/Billy Spaulding �206.310.4153
The Spinoffs/Dawnzella Gearhart �206. 718.1591
The VuDudes 206.999.0729
The Wired Band �206.852.3412
The Wulf Tones �206.367.6186 or 206.604.2829
Tim Hall Band �253.857.8652
Tim Turner Band �206.271.5384
Tommy Wall �206.914.9413
Town Hall Brawl �206.940.9128
Two Scoops Combo �206.933.9566
Two Trains Runnin’ 206.225.9684

U
Unbound �425.231.0565
Under the Puddle 425-512-3153

V
Virginia Klemens Band �206.632.6130

W
West Coast Women’s Blues Revue �206.940.2589
Whitewing  360.393-1687
Willie B Blues Band �206.451.9060
Willie & The Whips �206.781.0444
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By Eric SteinerBy Eric Steiner
This issue is unique in two very distinct This issue is unique in two very distinct 
ways: 1) It has an unprecedented number ways: 1) It has an unprecedented number 
of feature articles, previews, or reviews of feature articles, previews, or reviews 
– 9!, and 2) It has the largest number of – 9!, and 2) It has the largest number of 
contributing photographers in the history contributing photographers in the history 
of the magazine – 15! of the magazine – 15! 
I wanted to build on prior articles about I wanted to build on prior articles about 
our magazine’s requirements for color our magazine’s requirements for color 
photography, advertising art, and graphics photography, advertising art, and graphics 
in the hopes of encouraging potential in the hopes of encouraging potential 
contributors to format their work so that contributors to format their work so that 
our printer can print it. our printer can print it. 
Before these images can land on the Before these images can land on the 
traditional, old school plates in the print traditional, old school plates in the print 
shop at Pacific Publishing in South Seattle, shop at Pacific Publishing in South Seattle, 
Editor Polly O’Keary and I review them Editor Polly O’Keary and I review them 
as we assemble each issue in the Adobe as we assemble each issue in the Adobe 
In Design program. More often than not, In Design program. More often than not, 
we wrestle with the types, formats, and we wrestle with the types, formats, and 
resolutions of images we receive.resolutions of images we receive.
Help Us Build a Better Bluesletter!Help Us Build a Better Bluesletter!
Each month, we continue to receive many, Each month, we continue to receive many, 
many color photos that look absolutely many color photos that look absolutely 
perfect on a camera phone, computer screen, perfect on a camera phone, computer screen, 
or online in social media, but too few of or online in social media, but too few of 
them are formatted correctly for traditional them are formatted correctly for traditional 
printed paper media (like the magazine you printed paper media (like the magazine you 
are holding in your hands). Many of them are holding in your hands). Many of them 
also have file titles automatically generated also have file titles automatically generated 
by the camera or phone, but more about file by the camera or phone, but more about file 
naming conventions in a little bit. naming conventions in a little bit. 
Where to Start?Where to Start?
For starters, I encourage potential For starters, I encourage potential 
contributors to refer to the Submissions contributors to refer to the Submissions 
Requirements on page 4 of any recent Requirements on page 4 of any recent 
issue, which lists our printer’s required issue, which lists our printer’s required 
formats. Far too frequently, well-meaning formats. Far too frequently, well-meaning 
photographers send in excellent pictures photographers send in excellent pictures 
direct from their cell phones without direct from their cell phones without 
pausing to review or edit their images in pausing to review or edit their images in 
photo editing software to format their photo editing software to format their 
images for print. This important pause does images for print. This important pause does 
two things: 1) Offers the photographer an two things: 1) Offers the photographer an 
opportunity to improve upon lighting, tone, opportunity to improve upon lighting, tone, 
or contrast, and 2) Includes a step to title or contrast, and 2) Includes a step to title 

the image with the names of the subject the image with the names of the subject 
and photographer so we can properly give and photographer so we can properly give 
photographers’ credit for their work (and photographers’ credit for their work (and 
correctly identify the subject in the picture).correctly identify the subject in the picture).
RGB or CMYK?RGB or CMYK?
If your camera or cell phone saves color If your camera or cell phone saves color 
images in the RGB (that’s Red-Green-Blue) images in the RGB (that’s Red-Green-Blue) 
format, that’s the preferred image type for format, that’s the preferred image type for 
screens on computers and cell phones. screens on computers and cell phones. 
Social media is filled with RGB images as Social media is filled with RGB images as 
these tend to be low-resolution (meaning these tend to be low-resolution (meaning 
small file size). More about size in a bit. small file size). More about size in a bit. 
My little iPhone ES saves my images in My little iPhone ES saves my images in 
RGB, and I do not know how to change RGB, and I do not know how to change 
the camera settings on it. However, I know the camera settings on it. However, I know 
if I want my new editor, Polly O’Keary, to if I want my new editor, Polly O’Keary, to 
consider one of my photos for publication, consider one of my photos for publication, 
I need to submit the picture according to I need to submit the picture according to 
Pacific Publishing’s requirements. Actually, Pacific Publishing’s requirements. Actually, 
it’s not just a requirement of our printer. For it’s not just a requirement of our printer. For 
traditional, paper print publications, CMYK traditional, paper print publications, CMYK 
(that’s Cyan-Magenta-Yellow-BlacK), is (that’s Cyan-Magenta-Yellow-BlacK), is 
the “coin of the realm.” The gold standard the “coin of the realm.” The gold standard 
in traditional, print media. That generally in traditional, print media. That generally 
means larger files saved at 300 dots-per-means larger files saved at 300 dots-per-
inch (DPI), which is a direct contrast to inch (DPI), which is a direct contrast to 
social media’s “lite” photos saved at 72 DPI. social media’s “lite” photos saved at 72 DPI. 
Size is Important!Size is Important!
In addition to file type (RGB or CMYK), In addition to file type (RGB or CMYK), 
Polly and I look at an image’s size as we Polly and I look at an image’s size as we 
prepare them for print. Many cover color prepare them for print. Many cover color 
images top 30 MB in size as CMYK is a images top 30 MB in size as CMYK is a 
dense (300 DPI) and large format. As a dense (300 DPI) and large format. As a 
result, many images for print far exceed result, many images for print far exceed 
email attachment size capacity. When that email attachment size capacity. When that 
happens, we ask contributors to send it happens, we ask contributors to send it 
files through a file sharing service such as files through a file sharing service such as 
Google Drive, Box or DropBox. Regarding Google Drive, Box or DropBox. Regarding 
an image’s size, our partners in printing at an image’s size, our partners in printing at 
Pacific Publishing are prepared to work Pacific Publishing are prepared to work 
with images with resolutions at 500 DPI with images with resolutions at 500 DPI 
or greater, as this file size may allow for or greater, as this file size may allow for 
greater detail, clarity, and sharpness. Please greater detail, clarity, and sharpness. Please 
also know that short cuts like adding extra also know that short cuts like adding extra 
DPI to a 72 DPI social media image will not DPI to a 72 DPI social media image will not 
work 99% of the time. work 99% of the time. 

File Type: JPG, PSD or TIF?File Type: JPG, PSD or TIF?
When Polly and I double-check the resolution When Polly and I double-check the resolution 
and formatting of images, graphics, and ad and formatting of images, graphics, and ad 
art, I look for the file extension. Generally, art, I look for the file extension. Generally, 
in my experience, the In Design program in my experience, the In Design program 
seems to prefer Photoshop (PSD) native seems to prefer Photoshop (PSD) native 
images instead of JPG or TIF files. As of press images instead of JPG or TIF files. As of press 
time, Polly is using file types that are new to time, Polly is using file types that are new to 
me, like PNG images, and I look forward to me, like PNG images, and I look forward to 
learning more about those types of files as learning more about those types of files as 
she grows into the position of editor. she grows into the position of editor. 
What’s in a (File) Name?What’s in a (File) Name?
Too many potential contributors submit Too many potential contributors submit 
images using file identifiers automatically images using file identifiers automatically 
supplied by their cell phones or 35mm supplied by their cell phones or 35mm 
cameras. When we receive photos with file cameras. When we receive photos with file 
names like DCS12345.jpg, we are unable to names like DCS12345.jpg, we are unable to 
provide a photo credit due the photographer provide a photo credit due the photographer 
on our magazine’s masthead on page 4. So, on our magazine’s masthead on page 4. So, 
please, use a file naming convention that please, use a file naming convention that 
allows Polly and me the flexibility to quickly allows Polly and me the flexibility to quickly 
identify the subject in the picture as well as identify the subject in the picture as well as 
the photographer, like 2023 June B Arnold by the photographer, like 2023 June B Arnold by 
K Anderson.psd. Again, this process provides K Anderson.psd. Again, this process provides 
the photographer with an opportunity to the photographer with an opportunity to 
review their work and improve or edit it with review their work and improve or edit it with 
photo editing software. photo editing software. 
A Step-by-Step GuideA Step-by-Step Guide
To practice formatting, I used the following To practice formatting, I used the following 
steps on a photo I took of Jimmy Burns’ steps on a photo I took of Jimmy Burns’ 
bass player at the Chicago Blues Festival bass player at the Chicago Blues Festival 
several years ago. I looked in a file from several years ago. I looked in a file from 
2014 and forgot the bass player’s name (but 2014 and forgot the bass player’s name (but 
I remembered that his dad played guitar in I remembered that his dad played guitar in 
Chicago’s legendary Ink Spots band). If I Chicago’s legendary Ink Spots band). If I 
used the photo in print, I wanted to identify used the photo in print, I wanted to identify 
him by name (and not just “Jimmy Burns’ him by name (and not just “Jimmy Burns’ 
Bass Player”). Bass Player”). 

1.	1.	 Open Photoshop and look for Open Photoshop and look for 
photo.photo.

2.	2.	 File > Open >DSC_0052.JPG (Pho-File > Open >DSC_0052.JPG (Pho-
to of Jimmy Burns’ bass player).to of Jimmy Burns’ bass player).

3.	3.	 File > Move To > Deskstop. I make File > Move To > Deskstop. I make 
an extra copy just in case work on an extra copy just in case work on 
the image in the desktop.the image in the desktop.

Got a Great Shot? Format It & Send It In!Got a Great Shot? Format It & Send It In!
A quick summary of Bluesletter photo, ad art, and graphics requirements.A quick summary of Bluesletter photo, ad art, and graphics requirements.
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I call Steps 4, 5, and 6, “The Hunnewell I call Steps 4, 5, and 6, “The Hunnewell 
Effect.” The late blues photographer Tom Effect.” The late blues photographer Tom 
Hunnewell taught me that “Photoshop has Hunnewell taught me that “Photoshop has 
already done a lot of work for you. Use three already done a lot of work for you. Use three 
quick automatic improvements when you quick automatic improvements when you 
can, and you’ll find they work more often can, and you’ll find they work more often 
than not,” he said. I’m forever thankful for than not,” he said. I’m forever thankful for 
Tom’s advice behind the keyboard when I Tom’s advice behind the keyboard when I 
format blues photos for the magazine. format blues photos for the magazine. 

4.	4.	 File > Image > AutoTone. Save File > Image > AutoTone. Save 
image.image.

5.	5.	 File > Image > Auto Contrast. Save File > Image > Auto Contrast. Save 
image. image. 

6.	6.	 File > Image > Auto Color. Save File > Image > Auto Color. Save 
image.image.

7.	7.	 File > Filter > Sharpen > Smart File > Filter > Sharpen > Smart 
Sharpen. To refine the image a Sharpen. To refine the image a 
little bit. Save image.little bit. Save image.

8.	8.	 File > Rectangular Marquee Tool File > Rectangular Marquee Tool 
> Select area to remove orphan > Select area to remove orphan 
microphone stand at right from microphone stand at right from 
image. Save image.image. Save image.

9.	9.	 File > Image > Crop. Image File > Image > Crop. Image 
enlarged and orphan mic stand no enlarged and orphan mic stand no 
longer in picture. Save image.longer in picture. Save image.

10.	10.	 File > Image > SizeFile > Image > Size
a.	a.	 Resize to 2.4 inches Resize to 2.4 inches 

wide (one column). Save wide (one column). Save 
image.image.

b.	b.	 Check final size is 2.4 Check final size is 2.4 
inches by 1.9 inches. inches by 1.9 inches. 
Save image.Save image.

c.	c.	 Double check resolution Double check resolution 
is at 300 DPI. Mine was is at 300 DPI. Mine was 
already at 300 DPI. Save already at 300 DPI. Save 

image.image.
11.	11.	 Google “Jimmy Burns Bass Google “Jimmy Burns Bass 

Player.” It’s E.G. McDaniel. Part of Player.” It’s E.G. McDaniel. Part of 
Chicago’s Ink Spots Family.Chicago’s Ink Spots Family.

12.	12.	 File > Image > Mode > Switch File > Image > Mode > Switch 
from RGB to CMYK. Save image.from RGB to CMYK. Save image.

13.	13.	 File > Save As > 2023 EG McDaniel File > Save As > 2023 EG McDaniel 
Bass Eric S (File title)Bass Eric S (File title)

a.	a.	 Change format to Change format to 
Photoshop. Save image. Photoshop. Save image. 

b.	b.	 Send 2023 EG McDaniel Send 2023 EG McDaniel 
Bass Eric S.psd to Bass Eric S.psd to 
Polly O’Keary for her Polly O’Keary for her 
consideration. consideration. 

Next month, I plan to use free, online Adobe Next month, I plan to use free, online Adobe 
tutorials to learn the difference between tutorials to learn the difference between 
about raster and vector images, and explore about raster and vector images, and explore 
Adobe’s free, online resizing tool. Adobe’s free, online resizing tool. 
I hope this article and step-by-step guide I hope this article and step-by-step guide 
provides potential contributors with enough provides potential contributors with enough 
information to correctly format and title information to correctly format and title 
photos for traditional, print publication. photos for traditional, print publication. 
Please consider using the free, online Please consider using the free, online 
tutorials at Adobe’s website or contact your tutorials at Adobe’s website or contact your 
nearest public library (as many Seattle-area nearest public library (as many Seattle-area 
libraries may provide patrons free access to libraries may provide patrons free access to 
Adobe products on-site). Adobe products on-site). 
Some public libraries may also provide Some public libraries may also provide 
access to other types of image editing access to other types of image editing 
programs, such as GIMP (that’s a free open programs, such as GIMP (that’s a free open 
source photo editing program called GNU source photo editing program called GNU 
Image Manipulation Program). Image Manipulation Program). 
Polly and I are grateful for each and every Polly and I are grateful for each and every 

EG McDaniel at the Chicago Blues Festival 
(Photo by Eric Steiner)

photo that we can use in print, and we are photo that we can use in print, and we are 
very, very lucky to have so many blues fans very, very lucky to have so many blues fans 
who want to share their photos with the who want to share their photos with the 
Washington Blues Society. Washington Blues Society. 
Got a great shot? Format it and send it in!
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MEMBERSHIP FORM

Washington Blues Society Sets Local Competitions for theWashington Blues Society Sets Local Competitions for the
2024 International Blues Challenge in Memphis!2024 International Blues Challenge in Memphis!

Washington Blues Society Contacts:Washington Blues Society Contacts:
Tony Frederickson, President 		 (206) 612-6055 		Tony Frederickson, President 		 (206) 612-6055 		 president@wablues.orgpresident@wablues.org
Rick Bowen, Vice President 		  (425) 422-5062 		Rick Bowen, Vice President 		  (425) 422-5062 		 vicepres@wablues.orgvicepres@wablues.org

The Washington Blues Society’s local competitions for the 2024 International Blues Challenge in Memphis have been set! The Washington Blues Society’s local competitions for the 2024 International Blues Challenge in Memphis have been set! 
It’s time for bands and solo/duo acts to make their plans to compete. One band and one solo/duo act will represent the It’s time for bands and solo/duo acts to make their plans to compete. One band and one solo/duo act will represent the 
Washington Blues Society (WBS) in Memphis at the world’s largest gathering of blues musicians on January 16-20, 2024 Washington Blues Society (WBS) in Memphis at the world’s largest gathering of blues musicians on January 16-20, 2024 
on Memphis’ fabled Beale Street.on Memphis’ fabled Beale Street.
We are working with multiple blues societies across the state to hold semi-finals to make it easier for blues acts to We are working with multiple blues societies across the state to hold semi-finals to make it easier for blues acts to 
participate. We will hold semi-final competitions on Sunday, June 4participate. We will hold semi-final competitions on Sunday, June 4thth in Snohomish (Venue TBA), on Sunday, June, 11 in Snohomish (Venue TBA), on Sunday, June, 11thth  
in Purdy (Venue TBA, on Sunday, June,18in Purdy (Venue TBA, on Sunday, June,18th,th, in Yakima (Venue TBA), on Sunday, June, 25 in Yakima (Venue TBA), on Sunday, June, 25thth in Spokane  (Venue TBA), on  in Spokane  (Venue TBA), on 
Sunday, July, 9Sunday, July, 9thth  in Seattle (Venue TBA). The finalists will compete on Sunday, August 26  in Seattle (Venue TBA). The finalists will compete on Sunday, August 26thth in Seattle at (Venue TBA). If we  in Seattle at (Venue TBA). If we 
receive more than 10 applicants for any semi-final event our Board may select applicants via a lottery on May 31receive more than 10 applicants for any semi-final event our Board may select applicants via a lottery on May 31stst, 2023.  , 2023.  
Each competition will follow the rules of The Blues Foundation. Each set will be limited to 25 minutes, and each competitor Each competition will follow the rules of The Blues Foundation. Each set will be limited to 25 minutes, and each competitor 
will be allowed one 15-minute set change. Any blues act that in resides in WA, OR, ID, MT, BC or ALB, may enter, and the will be allowed one 15-minute set change. Any blues act that in resides in WA, OR, ID, MT, BC or ALB, may enter, and the 
act must include at least one who is a blues society member of an associated Greater Pacific Northwest Blues Society act must include at least one who is a blues society member of an associated Greater Pacific Northwest Blues Society 
must be verified as part of the IBC entry. The contest entry application may be downloaded from www.wablues.orgmust be verified as part of the IBC entry. The contest entry application may be downloaded from www.wablues.org, or in , or in 
Each applicant is required to pay the  non-refundable entry fee, which pays for the backline and a PA system. Each winner Each applicant is required to pay the  non-refundable entry fee, which pays for the backline and a PA system. Each winner 
will be required to perform at a minimum of two fundraisers in 2023 and one fundraiser in 2024 at no charge. Proceeds will be required to perform at a minimum of two fundraisers in 2023 and one fundraiser in 2024 at no charge. Proceeds 
from these events and fees, will be deposited into a WBS fund to help defray expenses to get each winning act to and from these events and fees, will be deposited into a WBS fund to help defray expenses to get each winning act to and 
from Memphis, but we cannot guarantee an “all-expense paid” trip. Band entry fee is $30; Solo/Duo entry fee is $15. from Memphis, but we cannot guarantee an “all-expense paid” trip. Band entry fee is $30; Solo/Duo entry fee is $15. 
Applications and entry fees must be received no later than Wednesday, May 24Applications and entry fees must be received no later than Wednesday, May 24thth, 2023. , 2023. 
All proceeds will help with expenses for Memphis. The WBS will help winners in fundraising, but cannot guarantee All proceeds will help with expenses for Memphis. The WBS will help winners in fundraising, but cannot guarantee 
that all expenses for Memphis will be covered. Judges will evaluate each act using Blues Foundation scoring criteria that all expenses for Memphis will be covered. Judges will evaluate each act using Blues Foundation scoring criteria 
(www.blues.org/ibc/scoring.php) and rules (www.blues.org/ibc/rules.php(www.blues.org/ibc/scoring.php) and rules (www.blues.org/ibc/rules.php).  ).  Acts may not be affiliated the WBS Board upon Acts may not be affiliated the WBS Board upon 
application. IBC rules also prohibit any act from competing three consecutive years at the IBC (www.blues.org/ibc/rules.application. IBC rules also prohibit any act from competing three consecutive years at the IBC (www.blues.org/ibc/rules.
php).  Application is an initial statement of interest and not a binding agreement between the applicant and the WBS.  php).  Application is an initial statement of interest and not a binding agreement between the applicant and the WBS.  
Make your plans to enter now! Applications and entry fees must be received no later than Wednesday, May 24Make your plans to enter now! Applications and entry fees must be received no later than Wednesday, May 24thth 2023. 2023.

** Please Note: We need at least two solo/duo acts and two band acts to hold a semi-final event. If we do not have enough ** Please Note: We need at least two solo/duo acts and two band acts to hold a semi-final event. If we do not have enough 
entries for one of our semi-finals, we will allow those affected to move to a different semi-final.**entries for one of our semi-finals, we will allow those affected to move to a different semi-final.**
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WASHINGTON BLUES SOCIETYWASHINGTON BLUES SOCIETY
2024 International Blues Competition (IBC) Contest2024 International Blues Competition (IBC) Contest

Two Categories: Bands (Three Piece and Larger) and Solo/Duo ActsTwo Categories: Bands (Three Piece and Larger) and Solo/Duo Acts
CONTESTANT APPLICATIONCONTESTANT APPLICATION

Please complete this application if you want to compete in the Washington Blues Society (WBS) contest to send a band or Please complete this application if you want to compete in the Washington Blues Society (WBS) contest to send a band or 
a solo/duo act to the IBC in Memphis in January 16-20, 2024. We are working with multiple blues societies across the state a solo/duo act to the IBC in Memphis in January 16-20, 2024. We are working with multiple blues societies across the state 
to hold semi-finals to make it easier for blues acts to participate. We will hold semi-final competitions on Sunday, June 4to hold semi-finals to make it easier for blues acts to participate. We will hold semi-final competitions on Sunday, June 4thth  
in Snohomish (Venue TBA), on Sunday, June, 11in Snohomish (Venue TBA), on Sunday, June, 11thth in Purdy (Venue TBA, on Sunday, June,18 in Purdy (Venue TBA, on Sunday, June,18th,th, in Yakima, (Venue TBA),  in Yakima, (Venue TBA), 
on Sunday, June, 25on Sunday, June, 25thth in Spokane, (Venue TBA), on Sunday, July, 9 in Spokane, (Venue TBA), on Sunday, July, 9thth  in Seattle (Venue TBA). If we receive 10+ applicants   in Seattle (Venue TBA). If we receive 10+ applicants 
for any event, our Board may select applicants via lottery on May 31for any event, our Board may select applicants via lottery on May 31stst.  This form is an initial statement of interest, and not .  This form is an initial statement of interest, and not 
binding. Judges will evaluate acts using the Blues Foundation score sheet (www.blues.org/ibc/scoring.php). binding. Judges will evaluate acts using the Blues Foundation score sheet (www.blues.org/ibc/scoring.php). 

LOCATION (CIRCLE ONE)LOCATION (CIRCLE ONE)
Snohomish (6/4)		                      Purdy (6/11)		                        Yakima (6/18)Snohomish (6/4)		                      Purdy (6/11)		                        Yakima (6/18)
                                   Spokane (6/25)                                    Seattle (7/9)                                   Spokane (6/25)                                    Seattle (7/9)

Band or Solo Duo (Circle One)

Contact

Mailing Address

Best Phone

Email

Signature

PARTICIPATION CRITERIA, FEES, AND DEADLINE: PARTICIPATION CRITERIA, FEES, AND DEADLINE: Contestants must be a blues act, pay the non-refundable Contestants must be a blues act, pay the non-refundable 
entry fee, reside in WA, OR, ID, MT, BC, or ALB, and at least one member must belong to (or join) the WBS upon entry fee, reside in WA, OR, ID, MT, BC, or ALB, and at least one member must belong to (or join) the WBS upon 
application. (Membership in the CBA, IEBS or Idaho/Montana based blues society will also meet blues society membership application. (Membership in the CBA, IEBS or Idaho/Montana based blues society will also meet blues society membership 
requirement) Entry fees go into a fund for winning Band and Solo/Duo to help with expenses for travel to Memphis, but requirement) Entry fees go into a fund for winning Band and Solo/Duo to help with expenses for travel to Memphis, but 
we cannot guarantee an “all-expenses paid” trip. Band entry fee is $30; Solo/Duo entry fee is $15. Applications and entry we cannot guarantee an “all-expenses paid” trip. Band entry fee is $30; Solo/Duo entry fee is $15. Applications and entry 
fees must be received no later than Wednesday, May 24fees must be received no later than Wednesday, May 24thth 2023 by a WBS Board member or at: 2023 by a WBS Board member or at:

Washington Blues SocietyWashington Blues Society
ATTN: President, IBC EntryATTN: President, IBC Entry

PO Box 70604PO Box 70604
Seattle, WA 98127Seattle, WA 98127
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The Washington Blues Society is a proud recipient of a 

2009 BLUES FOUNDATION 
KEEPING THE BLUES ALIVE AWARD


